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EMC Information

FEDERAL COMMUNICATIONS COMMISSION INTERFERENCE 
STATEMENT

This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the 
user will be required to correct the interference at his own expense.

FCC Caution: Any changes or modifications not expressly approved by the party 
responsible for compliance could void the user's authority to operate this equipment.

Warning: Operation of this equipment in a residential environment could cause radio 
interference.

KCC Statement

RoHS

This product is RoHS compliant.

Safety

This product has been classified as Information Technology Equipment.
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User Information

Online Registration
Be sure to register your product at our online support center:

Telephone Support
For telephone support, call this number:

User Notice
All information, documentation, and specifications contained in this manual 
are subject to change without prior notification by the manufacturer. The 
manufacturer makes no representations or warranties, either expressed or 
implied, with respect to the contents hereof and specifically disclaims any 
warranties as to merchantability or fitness for any particular purpose. Any of 
the manufacturer's software described in this manual is sold or licensed as is. 
Should the programs prove defective following their purchase, the buyer (and 
not the manufacturer, its distributor, or its dealer), assumes the entire cost of all 
necessary servicing, repair and any incidental or consequential damages 
resulting from any defect in the software.

The manufacturer of this system is not responsible for any radio and/or TV 
interference caused by unauthorized modifications to this device. It is the 
responsibility of the user to correct such interference.

The manufacturer is not responsible for any damage incurred in the operation 
of this system if the correct operational voltage setting was not selected prior 
to operation. PLEASE VERIFY THAT THE VOLTAGE SETTING IS 
CORRECT BEFORE USE.

International http://eservice.aten.com 

International 886-2-8692-6959

China 86-400-810-0-810

Japan 81-3-5615-5811

Korea 82-2-467-6789

North America 1-888-999-ATEN ext 4988
1-949-428-1111
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Package Contents

VK0100
The VK0100 package consists of:

1 VK0100 8-Button Control Pad (US, 1 Gang)
1 Button Pack
6 Terminal Blocks
1 Faceplate
1 User Instructions*

VK0200
The VK0200 package consists of:

1 VK0200 12-Button Control Pad (EU, 2 Gang)
1 Button Pack
6 Terminal Blocks
1 Faceplate
1 User Instructions*

VK1100
The VK1100 package consists of:

1 VK1100 Compact Control Box
4 Terminal Blocks
1 Power Cord
1 User Instructions*

VK2100
The VK2100 package consists of:

1 VK2100 Control Box
1 Rack Mount Kit
9 Terminal Blocks
1 Power Cord
1 User Instructions*
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Note:
Read this manual thoroughly and follow the installation and operation 
procedures carefully to prevent any damage to the ATEN controller and 
other connected devices.
The product firmware may have been updated with new features after the 
release of this manual. For an up-to-date user manual, visit: 
http://www.aten.com/global/en/

http://www.aten.com/global/en/
http://www.aten.com/global/en/
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About this Manual

This user manual is provided to help you get the most from your ATEN Control 
System. It covers all aspects of installation, configuration, and operation of the 
ATEN controllers and their accessories, including:

An overview of the information found in the manual is provided below.

Chapter 1, Introduction
Introduces you to the ATEN Control System. Its purpose, features, and benefits 
are presented, and panel components of the Control Box and Control Pad are 
described.

Chapter 2, Hardware Setup
Provides the necessary steps to setup the ATEN Control System installation, 
including how to wire the different types of hardware connections.

Chapter 3, Browser Operation
Provides information about Control Box and Control Pad’s web interface and 
how to use it to remotely configure parts of the ATEN Control System 
installation.

Chapter 4, ATEN Configurator (VK6000)
Provides a complete description of the ATEN Configurator (VK6000) software 
and how to use it to configure and operate the ATEN Control System.

Chapter 5, ATEN Database Generator
Provides a complete description of the Database Generator software and how 
to use it to configure new devices to add to the VK6000 device library.

Device Category Device Model Device Name

ATEN Control Box VK1100 ATEN Compact Control Box

VK2100 ATEN Control Box

ATEN Control Pad VK0100 8-Button Control Pad (US, 1 Gang)

VK0200 12-Button Control Pad (EU, 2 Gang)

ATEN Keypad VK108US 8-Button Keypad (US, 1 Gang)

VK112EU 12-Button Keypad (EU, 2 Gang)

ATEN Extension Box VK224 4-Port Serial Expansion

VK236 6-Port IR/Serial Expansion Box

VK248 8-Channel Relay Expansion Box

VK258 8-Channel Digital I/O Expansion Box
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Chapter 6, Remote PC Control
Explains how to set up your computer for remote control from a licensed 
device and provide a complete description of the supported control actions.

Chapter 7, ATEN Control System App
Provides a complete description of the ATEN mobile app and how to use it to 
operate devices connected to the ATEN Control System.

An Appendix
Provides specifications and other technical information regarding the ATEN 
Control System.

Conventions

This manual uses the following conventions:

Monospaced Indicates text that you should key in.

[ ] Indicates keys you should press. For example, [Enter] means to 
press the Enter key. If keys need to be chorded, they appear 
together in the same bracket with a plus sign between them: 
[Ctrl+Alt].

1. Numbered lists represent procedures with sequential steps.

♦ Bullet lists provide information, but do not involve sequential steps.

→ Indicates selecting the option (on a menu or dialog box, for 
example), that comes next. For example, Start → Run means to 
open the Start menu, and then select Run.

Indicates critical information.
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Terminology

Product Information

For information about all ATEN products and how they can help you connect 
without limits, visit ATEN on the Web or contact an ATEN Authorized 
Reseller. Visit ATEN on the Web for a list of locations and telephone numbers:

Terminology Description

ATEN Controller, 
controller

ATEN Controller or controller refers to all models of ATEN Control 
Box (VK1100 and VK2100) and ATEN Control Pad (VK0100 and 
VK0200).

ATEN Control Box, 
Control Box

ATEN Control Box or Control Box refers to all models of ATEN 
Control Box, including the VK2100 Control Box and the VK1100 
Compact Control Box.

Viewer, Profile A Viewer or Profile is a software control interface users 
customize to control and operate devices in their control system. 
A Viewer or Profile is configurable using ATEN Configurator and 
applied to a supported hardware control device, such as a mobile 
device, ATEN Keypad, or ATEN Control Pad to be able to 
function.

Project A project is a set of configuration for an ATEN Control System, 
including configuration of one or more controllers, managed 
devices, and profiles.

International http://www.aten.com

North America http://www.aten-usa.com
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Chapter 1
Introduction

Overview

The ATEN Control System, incorporating the ATEN Control Box/ATEN 
Control Pad (controller), the ATEN Configurator software (VK6000), and the 
ATEN Control System App is a standard Ethernet-based management system 
that connects all hardware devices in a room or large facility to provide 
centralized control of devices directly and effortlessly via a mobile device. The 
ATEN controller works as the main controller that provides great connectivity 
to all sorts of hardware devices commonly seen in a room. After connecting the 
hardware, the ATEN Configurator (VK6000) provides simple setup of the 
devices with easy step by step configuration. The ATEN Control System App 
then connects you to the controller from any iOS, Android or Windows mobile 
device / tablet computer which empowers you with mobility to control all the 
hardware devices, in different rooms, whenever and however you like.

ATEN Control Box/Control Pad easily deploys into an existing installation and 
integrates seamlessly with ATEN VanCryst pro-AV products and nearly any 
other hardware devices found in a room, including AV equipment, lighting, 
conference systems, air conditioning, motion sensors, power switches and 
many more. The controller serves as the central platform where hardware 
devices are connected – to be monitored, managed, and controlled directly via 
a tailor-made GUI from any iOS, Android, or Windows mobile device.

The VK6000 Configurator software facilitates quick setup and control of the 
devices in a few easy steps via an intuitive GUI. The VK6000 walks you 
through configuring the hardware, designing the control interface, and 
uploading this configuration to the controller. To provide control of the 
connected devices, you can create and customize a Viewer, a control interface 
for mobile devices and via the ATEN Control System App from any iOS, 
Android or Windows mobile device. Through an Ethernet connection, the 
ATEN Control System App enables you to edit and download Viewers from 
the controller via a point-n-tap user interface. Each Viewer is a customized 
control interface that grants you quick access to target and control hardware 
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devices. Use of any Viewer is protected with password authentication to ensure 
secure access.

The ATEN Control System is perfectly applicable in meeting rooms, 
conference centers, boardrooms, classrooms or any room that requires central 
and mobile control of a variety of hardware devices through a streamlined 
management system with optimum efficiency and performance.
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Benefits

Intelligent Control
The ATEN Control System makes the interactions between your hardware 
devices smarter. Pre-programmed actions and triggers can provide a fully 
automated series of advanced operations that allow your devices to respond to 
each other intelligently, making your whole solution run smarter and smoother.

Optimized Performance
The ATEN Control System has optimized the communication protocols that 
not only maintain a near-zero response time but also feature data encryption for 
extra protection.

Simplified Setup
No matter how large the room or how complicated the hardware, the ATEN 
Control System can be deployed in 3 easy steps: connect the hardware, 
configure the system and upload Viewers via a smart mobile app. Through an 
intuitive GUI, the process for setting up the controls for every room is simple 
and customizable, via straightforward predefined commands and macros, that 
do not require you to have complicated programming skills.

Effortless Expandability
With a range of expansion boxes available, the ATEN Control System 
installation can grow to accommodate additional Serial, Relay and IR devices. 
Furthermore, the ATEN Library has 10,000+ device drivers and grows as you 
add new devices to the existing database via the Database Generator, making 
it expandable and easily manageable, whatever the size or scope of the 
installation.

User Centered Convenience
An advanced, single-software solution creates an intuitive interface for any 
mobile device, while specific needs are customizable by selecting from an 
extensive library of actions and design elements to customize the control panel. 
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In addition, the ATEN Control System provides various support services that 
include driver downloads, database generation and upgrade tools – to help 
system integrators build easy-to-control environments effortlessly.

On-the-Go Control
Intuitive system control can start with one room and scale up to multiple rooms 
in the same area or across regions. Toggling between Viewers on an iOS, 
Android or Windows mobile device facilitates control of different rooms with 
simple point-n-tap operations. In addition, multiple mobile devices can be 
authorized with access to control the same room or multiple rooms, providing 
you with flexible, enhanced mobility, and tight security.
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Features

ATEN Control Box
Supports various connection interfaces:

DC outputs for power supply connections
VK2100: equipped with 4 DC outputs
VK1100: equipped with 1 DC output

1 x USB port for easy Viewer upload
IR Learning function for adding IR device drivers
Supports native KNX IP for building management systems
Telnet, TCP, UDP, ONVIF, PJLink, HTTP, and HTTPS compliant
Supports project file backup
Supports up to 8 ATEN Keypads
Web GUI for easy system configuration
2 free licenses for mobile control*
Supports SSH communication for data monitoring
Rack-mountable

Note: If you need more than two licenses for mobile control, contact your 
local sales representative. 

Interface VK2100 Control Box VK1100 Compact Control Box

Serial Port 6 2

IR/Serial Port 4 2

Relay Channel 4 4

I/O Channel 4 -

Ethernet Port 1 1
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ATEN Control Pad
Supports various connection interfaces:

2 RS-232 serial ports
2 relay channels
1 digital input port
1 Ethernet port

Designed to mount in 2-gang EU type and MK type junction boxes (for 
VK0200)
Fully customizable layout

VK0100: 14 layout variations using 4 to 8 buttons
VK0200: 125 layout variations using 6 to 12 buttons

Customizable button text engraving service
System LED indicators for quick connection status check
Dual-color LEDs for clear indication in dark environments
Redundant power supplies (DC power and PoE)
Supports native KNX IP for building management systems
Telnet, TCP, UDP, ONVIF, PJLink, HTTP, and HTTPS compliant
Supports project file backup
Web GUI for easy system configuration
Supports SSH communication for data monitoring

Note: To control your setup using a mobile device, contact your local sales 
representative to purchase licenses for mobile control. 
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ATEN Configurator
Simple Viewer setup with easy configuration steps via intuitive GUI
Customizable GUI to be used on mobile devices and PC
Supports ControlAssist that allows PC control (PC shutdown, media files, 
PowerPoint files)*
Built-in Database Generator for device driver setup and overall device 
management.
Built-in ATEN Library comprising 10,000+ device drivers and complete 
ATEN VanCryst product drivers
Event scheduling
Two-way communication enables user-defined event monitoring to 
automatically trigger the next actions
Test tool to verify commands in action before uploading the Viewer to the 
ATEN controller
Simulator to simulate and review the customized GUI before uploading

Note: For details on the supported PC control actions, see Supported PC 
Control Actions, page 215. 

ATEN Control System App
Allows administrators central control of multiple rooms via Viewers on a 
mobile device or tablet computer
Restrict user access to Viewers via password authentication
Synchronization of system controls amongst multiple mobile devices and 
tablet computers
Any iOS, Android, or Windows mobile device can be used to control the 
system – no need to purchase costly
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ATEN Keypads
Fully customizable layout

VK108US: 14 layout variations using 4 to 8 buttons
VK112EU: 125 layout variations using 6 to 12 buttons

System LED indicators for quick connection status check
Dual-color LEDs for clear indication in dark environments
Easy ID pairing with ATEN controller for Ethernet communication
Scalability – an ATEN controller can connect up to 8 Keypads
Versatile modes support flexible behavior settings for each button
Intuitive Web GUI for easy configuration
Redundant power supplies (DC power and PoE)
Button engraving service
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Requirements

Prepare the following equipment and make sure your equipment meets the 
minimum requirements specified below.

Hardware devices to be controlled by your ATEN controller
Bi-directional RS-232/422/485 serial devices
One-way IR or serial transmitter hardware devices (for Control Box 
only)
Relay hardware devices
Digital input hardware devices (for VK2100 and Control Pad only)
Digital output hardware devices (for VK2100 only)
Ethernet-controlled PJLink, Telnet, ONVIF, TCP, UDP, HTTP, or 
HTTPS devices
KNX IP interfaces for connecting KNX-compliant devices

Cables
One Cat 5e/6 Ethernet cable used to connect the ATEN controller to 
the local area network
(Optional) For serial devices with DB9 connectors, use standard 
straight-through cables.

A computer for configuring your ATEN Control System 
Make sure the computer runs Windows 7, 8, 8.1, 10, or any of the later 
versions.
Make sure to install .NET Framework version 4.5 or any of the later 
versions to the computer before using the ATEN Database Generator.

(Optional) Up to 10 mobile devices for remote control

Note: A license is required for each mobile device. For detailed 
information, see Licenses for Mobile Control, page 59.
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Accessories

Optionally purchase ATEN accessories to enhance the functionality of your 
Control System. For more information, visit the ATEN website. Contact your 
ATEN dealer to purchase these accessories.

Model Description

2XRT-0004G Full Range IR Emitter (1.8 m)

2X-031G Single Rack Mount Kit for VK1100

VK108US 8-button Keypad (US, 1 Gang)

VK112EU 12-button Keypad (EU, 2 Gang)

VK224 4-Port Serial Expansion Box

VK236 6-Port IR/Serial Expansion Box

VK248 8-Channel Relay Expansion Box

VK258 8-Channel Digital I/O Expansion Box

SA0141 DB9-F to RJ45-F Adapter

SA0145 RJ45-F to DB9-M Adapter
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Chapter 2
Hardware Setup

ATEN Control Box

Panel Components

VK2100 Front View

No. Component Description

1 Relay LED The LED lights green to indicate an active device connection 
(closed loop).

2 IR/Serial LED The LED lights green to indicate an active device connection 
and IR/Serial signals are being transmitted.

3 I/O LED The LED lights green to indicate an active device connection 
and I/O signals are being transmitted.

4 Serial LED The LED (1~6) lights green to indicate serial signals are 
being transmitted.

1. Important safety information regarding the placement of this 
device is provided on Safety Instructions, page 233. Please 
review it before proceeding.

2. Make sure that the power to all devices connected to the 
installation are turned off. You must unplug the power cords of 
any computers that have the Keyboard Power On function.

1 1052 43 6 7 8 9



ATEN Control System User Manual

12

5 Ethernet LED The LEDs provide information about the network 
connection:

Link: The LED blinks green to indicate Ethernet signals 
are being transmitted.

ACT: The LED lights green to indicate 100Mbps transmis-

sions.

6 DC Overload LED The LED lights orange to indicate DC output exceeds 
maximum output.

Note: When the LED lights orange, please unplug any of the 
connected devices to keep its total output under 24W.

7 IR Receiver / LED This IR receiver passes the functions of a remote control to 
the VK2100 in learning mode. The distance between the IR 
remote and the receiver window should be kept under 10cm 
with a direct line of sight.

The LED blinks green to indicate the unit is ready to 
receive signals from an IR remote control.

8 USB Port / LED This is where a USB device plugs in to upload Viewers to 
the VK2100.

The LED blinks green to indicate that Viewers are being 
uploaded, and lights green to indicate that the upload was 
successful.

The LED lights orange to indicate Viewers were not 
successfully uploaded.

9 Reset Switch To clear all the configurations except the network 
settings, press and hold the Reset Switch for 8 seconds.

To reset the network settings, press the Reset Switch 
once.

10 Power LED Lights green when the unit is turned on. 

No. Component Description
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VK2100 Rear View

No. Component Description

1 Grounding Terminal The grounding wire attaches here.

2 Power Socket This is a standard 3-pin AC power socket. The power 
cord from an AC source plugs in here.

3 Power Switch This is a standard rocker switch that powers the unit 
on and off.

4 DC Output Ports Four outputs provide a total power output of 24W /2A 
max.

5 Relay Channels Four channels; normally open, isolated relays with a 
contact rating of 24VDC, 2A max.

6 IR / Serial Ports Four IR ports that can also be configured as RS-232 
TX ports. pin1: Signal / pin2: Ground. 

7 I/O Channels Four channels that can be configured as digital input 
or digital output ports. 

Digital Input: 0-24VDC programmable input range or 
contact closure with +12VDC pull-up

Digital Output: 250mA sink from 12VDC

Pin1~4: Signal / Pin5: Ground

8 RS-232 Serial Ports Two RS-232 ports with TX/RX functions supported.

9 RS-232/422/485 
Serial Ports

Four ports with supported RS-232/422/485 conversion 
by pin assignment and RTS/CTS flow control. The 
RS232, RS422, or RS485 connection is defined by 
pin. For pin assignments, see page 33.

10 Ethernet Port This RJ-45 port is used for the network connection. If 
no IP address is assigned within 30 seconds, the 
default IP settings will be used:

IP: 192.168.0.60 / mask: 255.255.255.0

11 Controller ID Switch This 16-segment switch is used to set an ID for the 
controller.

1 2 3 4 5 6 87 119 10



ATEN Control System User Manual

14

VK1100 Front View

No. Component Description

1 Relay LED The LED lights green to indicate an active device 
connection (closed loop).

2 IR/Serial LED The LED lights green to indicate an active device 
connection and IR/Serial signals are being transmitted.

3 Serial LED The LED (1~2) lights green to indicate serial signals 
are being transmitted.

4 Ethernet Link / ACT 
LED

The LEDs provide information about the network 
connection:

Link: The LED blinks green to indicate Ethernet sig-

nals are being transmitted.

ACT: The LED lights green to indicate 100Mbps 
transmissions.

5 DC Output Overload 
LED

The LED lights orange to indicate DC output exceeds 
maximum output.

Note: When the LED lights orange, please unplug any 
of the connected devices to keep its total output under 
12W.

6 IR Receiver / LED This IR receiver passes the functions of a remote 
control to the VK1100 in learning mode. The distance 
between the IR remote and the receiver window 
should be kept under 10cm with a direct line of sight.

The LED blinks green to indicate the unit is ready to 
receive signals from an IR remote control.

1 2 3 5 6 7 84 9 10
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7 USB Port / LED This is where a USB device plugs in to upload Viewers 
to the VK1100.

The LED blinks green to indicate that Viewers are 
being uploaded, and lights green to indicate a 
successful upload of Viewers.

The LED lights orange to indicate that Viewers were 
not successfully uploaded.

8 Controller ID Switch This 16-segment switch is used to set an ID for the 
controller.

9 Reset Switch To clear all the configurations except the network 
settings, press and hold the Reset Switch for 8 
seconds.

To reset the network settings, press the Reset 
Switch once.

10 Power LED Lights green when the unit is turned on. 

No. Component Description
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VK1100 Rear View

No. Component Description

1 Power Socket This is a standard 3-pin AC power socket. The power 
cord from an AC source plugs in here.

2 Power Switch This is a standard rocker switch that powers the unit 
on and off.

3 Relay Channels Four channels; normally open, isolated relays with a 
contact rating of 24VDC, 2A max.

4 DC Output Ports One output provides a total power output of 12W max.

5 IR / Serial Ports Two IR ports that can also be configured as RS-232 
TX ports. pin1: Signal / pin2: Ground. 

6 RS-232/422/485 
Serial Ports

Two ports with supported RS-232/422/485 conversion 
by pin assignment and RTS/CTS flow control. The 
RS232, RS422, or RS485 connection is defined by 
pin. For pin assignments, see page 33.

7 Ethernet Port This RJ-45 port is used for the network connection. If 
no IP address is assigned within 30 seconds, the 
default IP settings will be used:

IP: 192.168.0.60 / mask: 255.255.255.0

8 Grounding Terminal The grounding wire attaches here.

1 2 3 4 5 76

8
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Rack Mounting the ATEN Control Box

VK2100

The VK2100 can be mounted in a 19” (1U) system rack. To install the device 
in a rack, do the following: 

1. Use the M3 x 8 Phillips head hex screws supplied with the Rack Mount 
Kit to screw the rack mounting brackets onto the front of the unit.

2. Position the unit in the front of the rack and align the holes in the mounting 
brackets with the holes in the rack.

3. Screw the mounting brackets to the rack.
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VK1100

Optionally purchase an ATEN Rack Mount Kit to install VK1100 in a 19” (1U) 
system rack. To install the device in a rack, do the following: 

1. Remove the side and bottom screws from the front of the VK1000.

2. Use the two bottom screws removed in step 1 to secure the bottom of the 
brackets, and two M3X6 hexagon screws (from the rack mount kit) to 
secure the side of the bracket to the VK1100.

3. Screw the mounting brackets to the rack.

M3X6 
Hexagon 
Screw



Chapter 2. Hardware Setup

19

Control Box Connections
Installation of the Control Box is a matter of connecting the appropriate wires. 
Refer to the installation diagrams on the pages that follow to setup each device 
and use the instructions below as a guide (each step provides a corresponding 
page with diagram for the VK2100 and VK1100), and do the following:

Connect the hardware devices to the Control Box using these instructions:

1. Use a grounding wire to ground the unit by connecting one end of the wire 
to the grounding terminal, and the other end of the wire to a suitable 
grounded object.

Note: Do not omit this step. Proper grounding helps prevent damage to the 
unit from surges or static electricity.

2. Use a Cat 5e/6 cable to connect the Control Box’s Ethernet port to the 
network.

3. Use the Controller ID Switch to assign an ID to this unit.

Note: It is possible to install more than 16 controllers under the same 
subnet. In which case, the 17th controller and the ones added after 
that will each be sharing its ID with another controller. If you have 
any ATEN Expansion Box and/or Keypad connected to controllers 
using shared IDs, reconfigure the connection mode. For details, see 
Controller Properties, page 89.

4. Use the DC Output terminals to wire 12VDC power connections using the 
instructions on page 25.

5. Use the Relay terminals to wire relay device connections using the 
instructions on page 27.

6. Use the IR/Serial (TX) terminals to wire IR or serial device connections 
using the instructions on page 28.

7. Use the Digital I/O terminals to wire digital Input/Output device 
connections using the instructions on page 30.

8. Use the RS-232 terminals to wire RS-232 serial device connections using 
the instructions on page 32.

9. Use the DB-9 ports to wire RS-232/422/485 serial device connections 
using the instructions on page 33.
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10. Connect IP-based devices to the same network as the Control Box. Refer 
to Ethernet, page 34 for details.

Note:
For KNX-compliant devices, connect the devices to a KNX IP 
interface, and then connect the KNX IP interface to the network where 
the Control Box is installed.
To check if the KNX functions are supported by the Control Box, see 
Datapoint Types, page 237.

11. Plug the power cord supplied with the package into the Control Box’s 3-
prong AC socket and then into an AC power source. 



Chapter 2. Hardware Setup

21

VK2100 Installation Diagram
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VK1100 Installation Diagram
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12VDC Power Output
One or four (VK1100 / VK2100) ports provide 12VDC of power with a total 
of 12 or 24 watts. The output can power one or four (VK1100 / VK2100) 
independent hardware devices, one or four (VK1100 / VK2100) loops for 
connected relay devices, or one or four (VK1100 / VK2100) digital output 
devices. If the combined current of the ports exceeds 1A (VK1100) or 2A 
(VK2100), the DC Power Overload LED lights orange, an alarm beeps three 
times and the ports are turned off. To return power to the ports, power off the 
Control Box, unplug all hardware connected to the 12VDC Power Output 
ports, power on the Control Box, and then plug in the hardware devices, one at 
a time, ensuring the current does not exceed 1A or 2A. 

The diagrams on the next three pages show ports on the VK2100. The VK1100 
is the same except that it has fewer 12VDC terminal blocks and no I/O ports. 

Independent Power Supply

 
Power Supply: 12VDC, 2A Max 

(24W shared by 4 ports)

Provides 12VDC power to 
independent hardware devices.

Connects to

4 x 12VDC Output Ports
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Relay Power Supply

Connects to

Provides 12VDC power 
for the relay loop.

 
Power Supply: 12VDC, 2A Max 

(24W shared by 4 ports)

4 x 12VDC Output Ports

Switch, Screen, Projector Lift, 
Lighting, Motorized Equipment, 

Motion Device, etc.
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Digital Output Power Supply (VK2100 only)

Power Supply: 12VDC, 2A Max 
(24W shared by 4 ports)

Connects to
Switch, Screen, Projector Lift, 

Lighting and Equipment Control.

4 x 12VDC Output Ports

Provides 12VDC power
for the digital output loop.
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Digital Output Dual Power Supply (VK2100 only)

Power Supply: 12VDC, 2A Max 
(24W shared by 4 ports)

4 x 12VDC Output Ports

Provides 12VDC power 
for the digital output loop.

Provides connection to 
digital output #2.

Provides connection to 
digital output #1.
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Relay
These four Relay channels provide connections to control hardware devices 
such as electric screens, projector lifts and other motorized equipment. Each 
relay is normally open by default. 

Normally
Open Closed

 
Normally Open, Isolated Relays
Contact Rating: 24VDC 2A Max

Switch, Screen, Projector Lift, 
Lighting, Motorized Equipment, 

Motion Device, etc.

Connects to

4 x Relay Channels
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IR / Serial
These two or four (VK1100 / VK2100) ports can be configured to connect IR 
and RS-232 devices. By default the ports are set to transmit IR signals. Use the 
ATEN Configurator software to configure the ports for RS-232 signals. The 
diagram below shows ports on the VK2100. The VK1100 is the same except 
that it has fewer terminals blocks and the Uni-directional setting is (0 to 5 V).

IR Connection: Connect a transmitter cable to the IR and Ground ports on the 
Control Box and install the IR transmitter on or near the device's IR receiving 
port, as shown on page 29.

Serial Connection: Connect the device's receiver (RX) and ground ports to the 
Serial (TX) and Ground ports on the Control Box. Next configure the same 
serial port setting on the Control Box and serial device so that they can 
communicate. 

Uni-directional (+ -5 V) 

Baud Rate: 300 to 115200 
(default: 9600)

Data Bit: 8 (default) or 7

Stop Bit: 1 (default) or 2

Parity: None (default), Even or 
Odd

IR: Blu-ray / DVD Player, TV, 
Audio Receiver, Projector, etc.

RS-232: Camera, Projector, 
Switch, Audio Mixer, Multimedia 
Device, etc.

Connects to

4 x RS-232 Ports

TTL Level (0 to 5 V)
Carrier Frequency: 

10kHz~455kHz

4 x IR Ports

or

VK2100
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One IR Transmitter

Two IR Transmitters

IR Receiver

Unidirectional IR

2 x IR Transmitters

IR Receiver



ATEN Control System User Manual

30

Digital I/O
The four channels on the VK2100 can be used to connect Digital Input or 
Digital Output hardware devices such as switches, sensors, LEDs and relays. 
Each channel can be configured as either an Input (VDC), Input (Dry Contact) 
or Output channel.

Digital Input (Dry Contact): 
Digital inputs are hardware devices (switches, sensors, monitors) with two 
circuit signals – open and closed. These two signals provide indicators from 
sensors or switches of an event. An event can be the on/off power, dry contact, 
sensor or switch status from a device. This information is used to trigger events 
and functions through the VK2100. 

Digital Input (VDC):
Digital input 12VDC hardware devices (temperature, current and monitor 
sensors) provide voltage signals between 1 and 24. A digital input port detects 
if a voltage is above/below a specific threshold (1 to 24). If the voltage 
coming from a hardware device is higher than the set value, the VK2100 will 
detect the digital input as high. If the voltage coming from a hardware device 

Connects to

4 x Programmable Digital
Input Channels

Digital Input 
VDC Mode: 

-Input Voltage Range: 0 to 24 VDC
-Programmable Range: 1 to 24 VDC

Dry Contact Mode:
 -Pull-up 2k ohms to + 12 VDC

Digital Input: Switches, Sensors 
Monitors and Button Triggers.
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is lower than the set value, the VK2100 will detect the digital input as low. 
This information is used to trigger events and functions through the VK2100. 

Digital Output: 
Digital output channels provide non-powered dry contact (open and closed) 
circuit control of hardware devices such as electric screens, projector lifts and 
other motorized equipment. Devices connected to the Digital Output port must 
be connected through a Relay Module, as shown below. 

Digital Output: Switch, Screen, 
Projector Lift, Lighting and 
Equipment Control.

Connects to

4 x Programmable Digital
Output Channels

Digital Output:
 250 mA sink from 12 VDC

Relay 
Module
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RS-232
The two bi-directional RS-232 ports on the VK2100 provide serial control of 
hardware devices (projectors, matrix switches, etc.) and receive status 
messages from the connected devices. For bi-directional RS-232 control, the 
transmit, receive and ground pins must be wired on both the VK2100 and 
hardware device. Each hardware device requires different wiring. Please 
consult each hardware device's manual for details.

Projector, Matrix Switch, 
Camera, etc.

Baud Rate: 300 to 115200 
(default: 9600)

Data Bit: 8 (default) or 7

Stop Bit: 1 (default) or 2

Parity: None (default), even or 
odd

Connects to

2 x Bi-directional RS-232 Ports
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RS-232 / 422 / 485
These two or four (VK1100 / VK2100) bi-directional ports provide serial 
control of hardware devices (projectors, switches, etc.) with programmable pin 
assignments and receive status messages from the connected devices. The 
diagram below shows ports on the VK2100. The VK1100 is the same except 
that it has fewer ports.

Pin Assignments

RS-232 RS-422 RS-485

Pin2: RX Pin1: RX- Pin3: D+

Pin3: TX Pin2: RX+ Pin4: D-

Pin5: GND Pin3: TX+

Pin7: RTS Pin4: TX-

Pin8: CTS Pin5: GND

Projector, Matrix Switch, 
Camera, etc.

Connects to

Configurable by pin assignment

Baud Rate: 300 to 115200 
(default: 9600)

Data Bit: 8 (default) or 7

Stop Bit: 1 (default) or 2

Parity: None (default), Even or 
Odd

Flow Control: None (default) or 
RTS/CTS

4 x Programmable 
Bi-directional RS-232/422/485 
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Ethernet
The RJ-45 port provides an Ethernet connection for GUI access (page 55) and 
the ability to add up to 25 LAN devices per Control Box or up to 8 LAN devices 
per Control Pad, as shown below. 

Ethernet

VK224 
VK236
VK248
VK258

Expansion Box

SELEC T

PDU
CURRENT

OUTLET 
CURRENT

IP
ADDRESS

SENSOR
1

SENSOR
2

OUTLET STATUS

ONVIF 

TCP 

PJLink 

Telnet

Telnet

1 x Ethernet Port

The RJ-45 port is used to connect 
the Control Box to the network and 
access TCP, UDP, PJLink, ONVIF, 
HTTP, HTTPS, and Telnet devices. 

If the network switch does not 
support DHCP, the installed device 

will adopt the default IP 
address,192.168.0.60

eco PDU

Modular Matrix Switch

Ethernet Switch

UDP

Lighting HVAC Systems

KNX IP Interface

HTTP
HTTPS

Video Conferencing System
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ATEN Control Pad

Panel Components
VK0100

VK0200

2 3

4

9 8

7
5

1

6

Front View Rear View

Side View

9

8

1

2
3

5

4 6 7

Front View

Rear View

Side View
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No. Component Description

1 Buttons and Button 
LEDs

Indicate the status of the Control Pad and the 
assigned function, e.g. lighting or projector.

When a button LED:

lights orange, the Control Pad is powered on 
and the button is off.

lights white, the Control Pad is powered on and 
the button is on.

When all button LEDs:

blink orange and white once, the Control Pad is 
restoring its default settings.

blink orange and white repeatedly, the Control 
Pad is being upgraded for its firmware.

2 System LEDs Contains a LAN and a Link LED to indicate network 
connection and data transmission status:

LAN LED lights green to indicate that the Control 
Pad is connected to network.

Link LED lights green to indicate that the Control 
Pad is actively transmitting and receiving data.

3 Reset Switch To clear all the configurations except the network 
settings, press and hold the Reset Switch for 8 
seconds.

To reset the network settings, press the Reset 
Switch once.

4 RS-232 Serial Ports Connect up to two RS-232 serial devices.

5 Relay Channels Connect up to two relay devices. Relay contacts are 
normally open, isolated with a contact rating of 24 VDC, 
1A max.

6 Digital Input Port Connect to one digital input device that supports 
programmable input (1 to 5 VDC) or dry contact (pull-up 
2k ohms to 5VDC).

7 Ethernet Port Connects to an Ethernet cable to provide power and 
access to the network.

8 Control Pad ID Switch Sets an ID for the Control Pad.

9 DC Power Port Connects to a 5V DC power adapter.
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Installing the Control Pads

Installation Steps

Follow the steps below to safely install the Control Pad.

VK0100

VK0200

Screen

Projector Video Switch

Projector
Projector

Lift

Ethernet
Cable

Camera

Network

Lighting
Control

Conference
System

Door
Sensor

Dry Contact
Device

PoE Switch

Relay

RS-232

DI

2

2
2

3

Relay

DI

Screen

Projector
Lift

Lighting
Control

Door
Sensor

Dry Contact
Device

2

Projector

Ethernet
Cable

Camera

Network
Conference
System

PoE Switch

RS-232
Projector Video Switch 2

2

2 3
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1. Prepare the installation site.

a) Choose a location where cables are free of interference.

b) Prepare a recession in the wall to accommodate the Control Pad. 
Download a CAD diagram from the product web page.

2. Connect the Control Pad to serial, relay, and/or digital input devices using 
the supplied terminal blocks. 
For details, see RS-232 Serial Connection, page 42, Relay Connections, 
page 43, Digital Input Device, page 44 respectively.

Note: To expand connection ports on the Control Pad, install ATEN 
Expansion Boxes.

3. To use PoE, connect the Control Pad to a PoE switch via an Ethernet cable.
For details, see Ethernet, page 45.

4. If you do not have power sourcing equipment for PoE, contact your local 
sales representative to purchase a power adapter and then follow the steps 
below to prepare the power cord.

a) Cut the connector end of the power adapter.

b) Strip 5 mm (0.5 cm) off the insulation cover of the power adapter cable 
to expose the +5V wire and the grounding wire.

c) Insert the expose +5V wire and the grounding wire tightly into the 
provided 2-pin terminal block connector.

Note: Use a voltmeter to determine the polarity of an exposed wire.

d) Plug the power terminal block to the DC power port on the Control Pad.

+5V

+5V

GND

GND

5mm (+)

(-)

4a

4b

4c
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5. Use the ID Switch to assign an ID to the Control Pad.

Note: It is possible to install more than 16 controllers under the same 
subnet. In which case, the 17th controller and the ones added after 
that will each be sharing its ID with another controller. If you have 
any ATEN Expansion Box and/or Keypad connected to controllers 
using shared IDs, reconfigure the connection mode. For details, see 
Controller Properties, page 89.

6. Power on all the devices. The button LEDs light orange.

7. Assemble the button caps onto the Control Pad. 

a) Assemble button caps of the same row with each other. 

b) From the top row, attach each row of button caps to the Control Pad by 
pressing on the hinges. 

Caution: When removing button caps, place your fingers on the top of 
button caps and then press downwards, as illustrated below. Pressing 
upwards from the bottom may cause damages to the button caps.
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8. Mount the Control Pad to the wall.

a) Secure the Control Pad to the wall with self-prepared screws.

b) Install the supplied faceplate to the Control Pad.
VK0100

VK0200 (EU)
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VK0200 (MK)
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RS-232 Serial Connection
The two bi-directional RS-232 ports on the Control Pad provide serial control 
of hardware devices (projectors, matrix switches, etc.) and receive status 
messages from the connected devices. For bi-directional RS-232 control, the 
transmit, receive, and ground pins must be wired on both the Control Pad and 
hardware device. Each hardware device requires different wiring. Please 
consult each hardware device's manual for details.

Projector, Matrix Switch, 
Camera, etc.

Baud Rate: 300 to 115200 
(default: 9600)

Data Bit: 8 (default) or 7

Stop Bit: 1 (default) or 2

Parity: None (default), even or 
odd

Connects to

2 x Bi-directional RS-232 Ports
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Relay Connections
These four Relay channels provide connections to control hardware devices 
such as electric screens, projector lifts and other motorized equipment. Each 
relay is normally open by default. 

Normally
Open Closed

 
Normally Open, Isolated Relays
Contact Rating: 24VDC 1A Max

Switch, Screen, Projector Lift, 
Lighting, Motorized Equipment, 

Motion Device, etc.

Connects to

2 x Relay Channels
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Digital Input Device
The digital input port on the Control Pad can be used to install a digital input 
device such as a switch or a sensor. The digital input channel can be configured 
to the VDC mode or the Dry Contact mode.

Digital Input (Dry Contact): 
Digital inputs are hardware devices (switches, sensors, monitors) with two 
circuit signals – open and closed. These two signals provide indicators from 
sensors or switches of an event. An event can be the on/off power, dry contact, 
sensor or switch status from a device. This information is used to trigger events 
and functions through the Control Pad. 

Digital Input (VDC):
Digital input 5VDC hardware devices (temperature, current and monitor 
sensors) provide voltage signals between 1 and 5. A digital input port detects 
if a voltage is above/below a specific threshold (1 to 5). If the voltage coming 
from a hardware device is higher than the set value, the Control Pad will 
detect the digital input as high. If the voltage coming from a hardware device 
is lower than the set value, the Control Pad will detect the digital input as low. 
This information is used to trigger events and functions through the Control 
Pad. 

Connects to

1 x Programmable Digital
Input Channel

Digital Input 
VDC Mode: 

-Input Voltage Range: 0 to 5 VDC
-Programmable Range: 1 to 5 VDC

Dry Contact Mode:
 -Pull-up 2k ohms to + 5 VDC

Digital Input: Switches, 
Sensors, Monitors, or Button 
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Ethernet
The RJ-45 port provides an Ethernet connection for GUI access (page 55) and 
the ability to add up to 8 LAN devices per Control Pad, as shown below. 

Ethernet

VK224 
VK236
VK248
VK258

Expansion Box

SELEC T

PDU
CURRENT

OUTLET 
CURRENT

IP
ADDRESS

SENSOR
1

SENSOR
2

OUTLET STATUS

ONVIF 

TCP 

PJLink 

Telnet

Telnet

1 x Ethernet Port

The RJ-45 port is used to connect 
the Control Box to the network and 
access TCP, UDP, PJLink, ONVIF, 
HTTP, HTTPS, and Telnet devices. 

If the network switch does not 
support DHCP, the installed device 

will adopt the default IP 
address,192.168.0.60

eco PDU

Modular Matrix Switch

Ethernet Switch

UDP

Lighting HVAC Systems

KNX IP Interface

HTTP
HTTPS

Video Conferencing System
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Accessories

ATEN Expansion Box
ATEN Expansion Boxes (sold separately) provide additional ports for a 
flexible expansion of the ATEN Control System. This allows you to add and 
control additional devices in an environment where more devices are required. 
With the advantage of an Ethernet-based connection, the expansion boxes are 
easily connected to the ATEN controller via a LAN connection from a variety 
of locations across a network. The diagram below provides an example of the 
VK224 4-Port Serial Expansion Box setup. 

Note:
To add and configure ATEN Expansion Boxes, see Device Configuration 
List, page 85 and Expansion Box, page 88.

The available Expansion Box models include:

Model Description

VK224 4-Port Serial Expansion

VK236 6-Port IR/Serial Expansion Box

VK248 8-Channel Relay Expansion Box

VK258 8-Channel Digital I/O Expansion Box

Control Box

Serial Devices

Network

SELECT

PDU
CURRENT

OUTLET 
CURRENT

IP
ADDRESS

SENSOR
1

SENSOR
2

OUTLET STATUS

Ethernet

Serial

VK224 (Rear)

Power Distribution 
Unit 

Video Matrix Projector Camera
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ATEN Keypad
The ATEN Keypad mounts to a wall to provide control of hardware through a 
Control Box. The setup of the Keypad to the Control System can be illustrated 
as follows:

Note: 
The following Keypad models are available:

You can have your Keypad buttons customized with text engraving. To 
make the order, go the this link: 
https://www.aten.com/ext_data/global_en/VK_Keypad_Engraving_Service/
aten_keypad.html

Model Description

VK108US 8-Button Keypad (US, 1 Gang)

VK112EU 12-Button Keypad (EU, 2 Gang)

Screen BD-Player

ProjectorLight Video Switch

Ethernet Switch

Powered by PoE
or DC 5V

VK1100
(Rear)

ATEN Keypad

https://www.aten.com/ext_data/global_en/VK_Keypad_Engraving_Service/aten_keypad.html
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Installation

To install the Keypad, follow the steps below:

1. Make sure you have created and uploaded a control interface (Viewer) for 
the Keypad and uploaded the Viewer to the Control Box. For details, see 
Design, page 100.

2. Prepare the installation site.

a) Choose a location where cables are free of interference.

b) Prepare a recession in the wall based on the following dimensions.
VK108US

50 cm (wall depth)

wall

54 cm (wall opening)
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54 cm (wall opening)
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 c
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)
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ew

 p
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h)

18 cm

12 cm

Installing with a wall box Installing without a wall box
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VK112EU

3. Adjust the keypad ID switch (blue) to assign an ID number for the 
Keypad.

4. Adjust the Control Box ID switch (black) to specify the ID number of the 
Control Box which the Keypad will work with. One ATEN Control Box 
can work with up to 8 Keypads.

5. Connect the Keypad to LAN using an Ethernet cable to provide network 
connectivity and power.

Note: PoE is only supported if a power sourcing equipment is installed.

6. If you do not have a power sourcing equipment to supply power through 
the Ethernet cable, follow the steps below to prepare the power adapter 
and then plug it to the Keypad.

Note: Optionally purchase an ATEN power adapter for this application.

60 cm (wall depth)

wall

111 cm (wall opening)

63 cm (screw pitch)

120.2 cm (screw pitch)

60
 c

m
 (w

al
l o

pe
ni

ng
)

52
.5
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m

 (s
cr

ew
 p

itc
h)

+5V

+5V

GND

GND

5mm

5a

5b
5c

(+)

(-)
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a) Cut the connector end of the power adapter cable.

b) Strip 0.5 cm off the insulation cover of the power adapter cable to 
expose the two wires, the +5V wire, and the grounding wire.

c) Insert the exposed wires into the supplied 2-pin terminal block.

Note: To determine the wire polarity, use a voltmeter.

7. The LAN and Link LEDs light green to indicate that the Keypad 
successfully links to the assigned Control Box.

Note:
Make sure that the Keypad is in the same subnet with its assigned 
Control Box. 
The Keypad adopts the default IP address 192.168.0.60 if the network 
switch does not support DHCP. To configure the IP address, log in the 
web interface using the default IP address and the default password 
(password).

8. Secure the Keypad to the wall.

9. Follow the layout created in the Viewer and assemble the button caps onto 
the Keypad. 

a) Assemble button caps of the same row with each other. 

b) From the top row, attach each row of button caps to the Keypad by 
pressing on the hinges. 
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Caution: When removing button caps, place your fingers on the top of 
button caps and then press downwards, as illustrated below. Pressing 
upwards from the bottom may cause damages to the button caps.

10. Attach the faceplate to the Keypad.
VK108US

VK112EU
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Component
The VK108US and VK112EU Keypads share the same hardware layout. For 
demonstration purpose, VK112EU is used as an example below.

No. Component Description

1 Buttons VK108US
The Keypad can be customized up to 14 different 
layouts using 4 to 8 buttons.

VK112EU
The Keypad can be customized up to 125 different 
layouts using 6 to 12 buttons.

2 Button LEDs A button LED:

Lights orange to indicate the power is on.

Lights white to indicate the Keypad is in operation.

Blinks orange and white to indicate that firmware 
upgrade is in progress.

3 System LED Indicators LAN: lights green to indicate that the Keypad is 
connected to LAN.

Link: lights green to indicate that the Keypad is 
connected to the assigned Control Box.

4 Reset Pushbutton Press to reset the Keypad to its default network 
settings.

5 DC Power Plug a power adapter into this DC power input.

6 Keypad ID Switch (blue) Sets an ID to the Keypad (1~8).

7 Control Box ID Switch 
(black)

Sets the ID of the Control Box (1 ~ 16) to which the 
Keypad connects.

2

37

5

6

4

1 8

68.51 mm

49.5 mm

28 mm
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Layout Examples
VK108US

VK112EU

8 LAN Port Connects the Keypad to LAN

Supplies power (PoE) if a power sourcing 
equipment is installed.

No. Component Description
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Chapter 3
Browser Operation

Overview

The ATEN controller can be configured over a standard TCP/IP connection via 
its built-in Graphical User Interface (GUI). Because it can be accessed from 
anywhere over a network or the Internet, operators can easily log in via a web 
browser. The web interface can be used to upload licenses, set the access key, 
enable monitors and update the firmware. 

Logging In

To access the GUI, type the IP address of the controller into the address bar of 
any browser. If a Security Alert dialog box appears, accept the certificate – it 
can be trusted. The Welcome screen appears:

The default IP address is http://192.168.0.60 

The default access key is: password

Only one user can log in at a time

Supports Internet Explorer browsers IE9 and higher
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Dashboard

The Dashboard appears when you successfully log in to the Control Box. The 
Dashboard gives a quick view of each setting and provides a link to each page. 
Click Manage to configure the settings. 

The top bar provides two options:

 Click to enter the Settings page. 

Click to log out of the web console. 
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Settings

The Settings view contains tabs to provide options to configure the controller. 
The page is divided into two parts, the Interactive Display Panel which is 
used to configure the options and the Top Bar which provides icons to exit the 
settings page and log out of the web session. 

The Settings page opens on the General tab, as shown below:

The General tab contains network, system time, and firmware upgrade settings. 

Controller Info Provides network and identification information pertaining to the 
controller.

Device Name: Sets the device name.

Controller ID: Displays the controller ID # set on the rear of the 
unit.

IP Address: Provides the IP address of the controller. 

MAC Address: Provides the hardware MAC address of the 
controller. 
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Date & Time Automatically

Time Zone: Select a time zone for the controller. Choose 
the city that most closely corresponds to where it is located. 

NTP Server Settings
Assign an NTP server for the controller to synchronizes its 
clock. If the controller have access to the Internet, configure the 
Preferred NTP Server and Alternate NTP Server settings. If 
the controller is installed in a closed network, configure the 
Preferred Customer Server IP and Alternate Customer 
Server IP settings.

Preferred NTP Server: Select an NTP server to provide 
synchronization services to the controller. Make sure to use 
an NTP server that is located close to where the controller 
is installed to minimize propagation delays.

Alternate NTP Server: Select an alternate NTP server to 
which the controller connects when it is unable to connect 
to the preferred NTP server. 

Preferred Customer Server IP: Select this option to use a 
private NTP server if the controller is installed in a closed 
network.

Alternate Customer Server IP: Select this option to set up 
a substitute server if the controller is unable to connect to 
the preferred server.

Adjust Time: Sets the interval at which the controller 
synchronizes its clock with the assigned NTP server.

Sync: Click this button to save your configuration and start 
synchronizing its clock with the assigned NTP server.

Manually: Use the drop-down lists to set the controller’s time 
zone, date, and time.

Firmware Displays the Current Firmware version and option to upgrade. 

Click Update Firmware to open the Firmware Upgrade window. 
Click Browse to select the firmware upgrade file.

When Check FW Version is selected, the system will check the 
current firmware version against the one being used to upgrade the 
controller. If the device version is higher than the upgrade version a 
dialog box informs you and gives you the option to continue or 
cancel.

After the file has been selected, click Update to start the firmware 
upgrade. 
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Licenses for Mobile Control
A license is a software permit that an ATEN controller grants to a mobile 
device for remote control. If you have three licenses for a controller, you can 
remotely operate the controller using three mobile devices at the same time. 
Refer to the table below for the number of free licenses and the maximum 
number of paid licenses each controller supports. To purchase additional 
copies of license, contact your local sales representative.

You can use the Licenses tab to:
Find out the total number of licenses, the number of licenses that are 
available, and those that are in use
Upload licenses to the ATEN controller
View license information

Licenses ATEN Control Box
(VK1100 / VK2100)

ATEN Control Pad
(VK0100 / VK0200)

No. of free licenses 2 0

Maximum no. of licenses 10 10

Licenses In Use: displays the number of licenses being used by mobile 
devices. 

Not in Use: displays the number of licenses available for use. 

Total shows the number of licenses purchased for the controller. 

Update License Clicking Add opens the Add License window to upload new licenses to 
the controller. Click Browse to locate the license file and Add to upload 
the license(s).

Remove When a device is accessing the controller, you can click the Remove 
button to disconnect the session. 
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Storage
The Storage tab displays information about the space available for storing 
Viewers on the controller.

Storage This section shows a graph displaying the percentage of space 
available on the controller to upload Viewers, as well as:

Space Used: The amount of space currently being used to store 
Viewers uploaded to the controller. 
Space Available: The amount of space currently available to 
store Viewers on the controller. 
Total Space: The total amount of space available to store 
Viewers on the controller. 

Existing Viewer This section lists all the Viewers that are currently stored on the 
controller with their name and assigned room. Click Remove to 
delete a single Viewer or Remove All to delete all Viewers from the 
controller. 
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Access
The Access tab allows you to configure the access key (password) of the ATEN 
controller’s web interface and to set a validity period for accessing the ATEN 
Control System using an activation key.

Access Key The access key is the password that is required to do the following:

Log in the ATEN controller’s web interface.

Upload projects and Viewers from Configurator to ATEN 
controller (page 182).

Download Viewers from ATEN controller to mobile devices 
using ATEN Control System App (page 231).

The following settings are available:

Current Access Key, New Access Key, Confirm Access 
Key: Use these three fields to set or change the access key. 
The default access key is password.
IMPORTANT: You will be prompted to modify the access key 
before you can continue with accessing the web GUI or 
uploading project files.

Show on dashboard: Select this option to show the access 
key setting on the Dashboard tab.

Enable Viewer Access Key: Select this option to request for 
the access key when uploading projects and Viewers to the 
ATEN controller or when downloading Viewers to mobile 
devices. Once enabled, you can also configure this setting from 
the Dashboard tab.
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Activation Key The activation key is a string of letters and numbers used to assign 
a validity period of accessing the ATEN Control System.

To set up a validity period for accessing the ATEN Control System:
1. Select Your access to ATEN Control System will expire in 

and type the number of days.

2. Type an activation key. Follow the guidelines below when 
creating your activation key:

Max number of characters: 32

Allowed characters: uppercase and lowercase letters, 
numbers, and underscore

Max. number of days: 999 days

3. Type the activation key again to confirm.

4. Click Save. The limit is immediately applied. For example: 

Note: Keep the activation key somewhere secure because it 
cannot be recovered. In case you forget the activation key, 
press the reset button/switch for 8 seconds to set the ATEN 
controller to default. This will reset all configuration of the 
controller to default and remove any projects and Viewers 
stored on the ATEN controller.

To disable the validity period, click Enter Activation Key to type the 
activation key provided by the system integrator.
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Monitor
The Monitor tab allows you to view and enable the monitors that have been 
configured for Flags and digital input devices in the VK6000 software. Check 
the Show on dashboard box to show the Monitor settings on the Dashboard. 
Click the slide bar next to the monitor you want to enable or use the drop-down 
menu to select All On or All Off.

For more information about creating monitors, see Library, page 152. 
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Network
The Network tab allows you to view and configure the controller’s network 
settings. Select Manually to set a static IP Address, Subnet Mask, and Default 
Gateway, or Use DHCP to have the server assign an IP address to the 
controller. 

Note: Make sure to set the ATEN controller’s IP address and Default Gateway 
to the same subnet. 
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Connections
The Connections tab allows you to view the connection statuses and IP 
addresses of licensed devices, ATEN Keypads, and ATEN Expansion Boxes. 
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Schedule
The Schedule tab lists scheduled events predefined using the ATEN 
Configurator. You can use this tab to do the following:

Enable or disable scheduled events.
Enable or disable scheduled days

For details on setting up scheduled events, see Scheduled Events, page 175.
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Security
The Security tab allows you to secure the browsing sessions between your 
computer and the ATEN controller’s web interface using SSL encryption. 
Purchase and obtain an SSL certificate from a trusted certifying authority and 
click Upload in this page to apply the certificate.
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Chapter 4
ATEN Configurator (VK6000)

Overview

The ATEN Configurator (VK6000) is a GUI-based management tool that helps 
you set up and configure the connected hardware and create control interfaces 
to be used by mobile devices and ATEN Keypads. 

Installation

To install the ATEN Configurator software, do the following:

1. Download ATEN Configurator.

a) Visit the ATEN download page.
http://www.aten.com/global/en/support-and-downloads/downloads/

b) Search for “VK6000”. A list of downloads for VK6000 appear.

c) Click ATEN_configurator_software_x.x.xxx.zip to download.

2. Open the downloaded zip file and double-click 
ATEN_configurator_software_x.x.xxx.exe to run the setup. This screen 
appears.

http://www.aten.com/global/en/support-and-downloads/downloads/
http://www.aten.com/global/en/support-and-downloads/downloads/
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3. Click Next. This screen appears.

4. If you agree with the License Agreement, select I accept the terms of the 
license agreement, and click Next. Click Print to print the Software End 
User License Agreement. This screen appears.
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5. To change the destination location, click Change. Click Next to proceed 
using the default location. This screen appears.

6. Click Install. When the process is complete, a confirmation message 
appears.

7. Click Finish.
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Getting Started Tasks

After you have installed and launched the ATEN Configurator, the Main Page 
(page 74) appears. You will be guided to create and configure a project using 
the 4 tabs in the Configurator’s interface, as illustrated below. 

Hint: You can click the tabs to switch among different pages for configuration. 

The steps below provides an overview of the getting started tasks.

1. In the Project tab, do the following.
Provide information about the ATEN controller that you have set up.
(Optional) Provide client information for the specified ATEN 
controller.
Click Add Controller if you have more than one controller in the 
environment.

For more details, see Project, page 82.

Click Start Project to proceed.

2. In the Device tab, do the following.
Connect each controller with its managed devices by adding them to 
the controller’s Device Configuration list, enter the connection 
settings, and specify the physical locations.
(Optional) Add another controller and/or Expansion Box to the project 
by clicking Add Controller or Expander.
Connect the Extension Box with its managed devices by adding them 
to the Extension Box’s Device Configuration list. 

For more details, see Device, page 84.

Click Design or the Viewer tab to proceed.
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3. In the Design tab, do the following.
Create and configure a control interface (Viewer). For more 
information, see Design, page 100.
(Optional) Set up scheduled events to automatically carry out specified 
actions.
(Optional) Add additional conditions and actions to buttons using 
Flags. For details, see Flag, page 153.
(Optional) Create a sequence of actions for a button by creating a 
Macro. For details, see Macro, page 173.
(Optional) Create a Variable for a device setting that is controlled by 
two or more components in one control interface. For details, see 
Variables, page 176.

4. In the Upload tab, upload this Viewer to the controller. For details, see 
Upload, page 182.



ATEN Control System User Manual

74

Main Page

Double-click the Configurator.exe shortcut to open the ATEN Configurator 
software. The Project page appears:

No. Control Description

1 Menu bar The Menu Bar contains categories with options that pertain 
to different sections of the software. Menu bar items are 
listed on page 76. 

2 Project Bar The Project Bar contains four tab and the Library icon. Each 
tab relates to a step required to set up the project. Each 
step and the Library can be selected by clicking on the bar. 
Each step is discussed, starting on page 82, and the 
Library on page 99.

3 Interactive Display 
Panel

This is the main work area. The page that appears here 
reflects the project tab that is selected. 

4 Library The Library contains the devices, graphic, flag, macro, and 
monitor databases. Each section allows you to add custom 
items or choose from ready made selections.

5 Toggle Bar These three icons are used as a toggle to show or hide the 
right, left and bottom control panel. 

2

1

3

4 5

6
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6 Simulator The Simulator button is used to test the Viewer after it is 
created in Design. The simulator allows you to tryout the 
interface as it would work on a mobile device but without 
actually controlling devices. Use the mouse to click through 
the page links. 

No. Control Description
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Menu Bar

Use the Menu Bar to select options in each project tab. The table below 
provides a description of each menu item. 

Menu Sub-Menu Description

File New Project Select to create a new project. 

Open Project Select to browse and open a previously 
saved project. 

Restore Project from Controller Downloads a previously backed up 
project from a controller.

Close Closes the current project and returns to 
the Project tab. 

Save Select to save changes to the current 
project. 

Save as Use this option to save the project as a 
different name.

Export Viewer to USB
(Not supported by ATEN Control 
Pad)

Exports Viewers and an access key to a 
USB drive. After exporting the data onto 
a USB drive, plug the USB drive into the 
Control Box’s USB port to upload the 
Viewer files and the access key. These 
files can only be read by the Control Box 
and are not project files that can be 
opened by the ATEN Configurator 
software.

Project Report Click to save a PDF file that contains 
detailed information about each part of 
the current project.

Import ETS Project Import an ETS project file for your KNX 
devices. 

Recent Projects Select to view a list of recent projects that 
can be clicked on to open. 

Exit Select to close the project and exit.
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Edit Undo Select to undo a change when editing a 
Viewer in Create & Design Viewer.

Redo Select to redo a change when editing a 
Viewer page in Create & Design Viewer.

Cut/Copy/Paste Select to cut, copy or paste text and 
objects when editing a Viewer page in 
Create & Design Viewer. When used to 
copy and paste a button, both the 
General and Action properties are 
copied. 

Paste Graphic Only Select to paste a button’s image but not 
its Action properties in Create & Design 
Viewer.

Delete Select to delete highlighted text and 
images when editing a page in Create & 
Design Viewer.

Delete Action Only Select to delete the Action properties of a 
button in Create & Design Viewer.

Select All / Deselect All Use either option to select or unselect all 
objects when editing a viewer page in 
Create & Design Viewer.

Preferences Display 
Language

Use to select the language for the 
interface.

SSH 
Destination

Click to choose the location of the 
executable for the SSH Client software. 
To execute the program, go to the menu 
bar and select Tools → SSH Client.

Interface Check a box to enable the feature 
described below:

Show Welcome Page: displays the 
Welcome screen when the ATEN Con-
figurator software opens. 
Auto Page Creation: automatically 
creates a Viewer page in Create 
Viewer & Design, for every hardware 
device that is configured in Select 
Device & Configuration.
Show Password: displays the charac-
ters of the access key in the Edit 
Access Key dialog box.
Automatically check for updates: 
automatically checks for updates and 
notify the user when an update is 
available.

Menu Sub-Menu Description
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View These options are available from Create Viewer & Design → Edit Viewer.

Zoom Zooms the Viewer page to 25%, 50%, 
75%, 100%, 200% or Fit in Window. 
Note: A mouse wheel can be used to 
zoom the Viewer page in or out. 

Project Information Select to go to Project Information.

Device Configuration Select to go to Select Device & 
Configuration.

Viewer Design Select to go to Create Viewer & Design. 

Project Upload Select to go to Search & Upload. 

Properties Select to show/hide the Properties 
window when editing a Viewer page.

Align to Grid Select to automatically align objects with 
the grid. This places objects in perfect 
alignment with the grid dots when they 
are moved. Use Show Grid to display the 
grid dots. When Align to Grid is not 
selected, objects can be placed 
anywhere on the page.

Show Grid Select to display the grid dots on the 
page. Use with the Align to Grid option to 
set objects in perfect alignment on the 
page. 

Object These options are available from Create Viewer & Design → Edit Viewer.

Button Adds a button to the Viewer page. 

Text Adds a text box to the Viewer page.

Image Adds an image to the Viewer page. 

Scroll View Adds a scroll box to the Viewer page, 
then double-click it to add buttons. Use 
the box as a scroll window to easily 
access a list of buttons on the page. 

Video Adds a video box which allows you to 
view video. The video box can be resized 
using the Properties sidebar or by 
dragging a small box on the boarder to 
resize it to the desired shape. 

Slider Bar Adds a slider bar to the Viewer page. 
Slider bars are used to adjust the value 
of a device setting, such as the volume 
level of an audio device. 

Menu Sub-Menu Description
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Object PowerPoint Control Template Adds a PowerPoint Control template to 
the Viewer. This control template is used 
to control PowerPoint files saved in a 
target computer.

Media Control Template Adds a Media Control template to the 
Viewer. This control template is used to 
control media files saved in a target 
computer.

Line Adds a line to visually separate objects 
on the Viewer.

Frame Adds a frame to visually frame an object 
or to group a set of objects in the Viewer.

Dial Kit Adds a dial kit to the Viewer. The dial kit 
can be used for dialing a meeting.

Group Group Select multiple objects and use Group to 
lock them together. Objects in the group 
will move together as one.

Radio 
Group

Select multiple buttons and use Radio 
Group to associate them as follows: 
selecting a button that belongs to the 
radio group deselects the previously 
selected radio button within the same 
group. 

Ungroup Select grouped objects and use 
Ungroup to unlock the group.

Order Bring to 
Front

Moves an object to the top position when 
objects are layered.

Send to 
Back

Moves an object to the bottom position 
when objects are layered. 

Bring 
Forward

Moves an object up one position when 
objects are layered. 

Send 
Backward

Moves an object down one position when 
objects are layered. 

Menu Sub-Menu Description
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Object Align Left Aligns two or more selected objects to 
the Left side of the object that is selected 
last. 

Center Aligns two or more selected objects to 
the horizontal position of the object that 
is selected last. 

Right Aligns two or more selected objects to 
the Right side of the object that is 
selected last. 

Top Aligns two or more selected objects to 
the Top side of the object that is selected 
last. 

Middle Aligns two or more selected objects to 
the vertical position of the object that is 
selected last. 

Bottom Aligns two or more selected objects to 
the Bottom side of the object that is 
selected last. 

Make Same Size Width Resizes two or more selected objects to 
the same width of the object that is 
selected last. 

Height Resizes two or more selected objects to 
the same height of the object that is 
selected last. 

Both Resizes two or more selected objects to 
the same width and height of the object 
that is selected last. 

Space Evenly Across 
Page Width

Spaces two or more selected objects 
evenly across the width of the page.

Across 
Page 
Height

Spaces two or more selected objects 
evenly across the height of the page.

Between 
Objects 
Horizontally

Adjusts the horizontal space between 
three or more selected objects to the 
average distance between each of the 
selected objects.

Between 
Objects 
Vertically 

Adjusts the vertical space between three 
or more selected objects to the average 
distance between each of the selected 
objects.

Menu Sub-Menu Description
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Tools Database Generator Opens the ATEN Database Generator 
which is used to manually add and 
configure hardware devices. This is 
where you can create custom devices to 
add to My Device Library. See ATEN 
Database Generator, page 185, for 
details.

Simulator The Simulator is used to test a Viewer’s 
interface after it has been created in 
Design. The simulator allows you to 
tryout the interface as it would work on a 
mobile device but without actually 
controlling devices. Use the mouse to 
click through the page links.

SSH Client This runs the SSH Client software 
selected under Edit → Preferences → 
SSH Destination. The SSH Client is used 
to communicate with the controller. 

Windows New Page Click to create a new Viewer page or 
select a page to open in Create Viewer & 
Design.

Help About Provides the firmware version and 
support information for the Configurator 
software. 

Check for Updates Checks if ATEN Configurator is up-to-
date.

Menu Sub-Menu Description
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Project

The Project tab allows you to enter details about the installation to start the 
project. Enter the information using the table below as a guide.

Control Description

Name Enter the project name you are setting up. You can create 
multiple projects but for most installations only one project is 
required. 

Add Controller Click to add controllers to the project. The number added 
should match the number of controllers installed. A project can 
have up to 16 controllers.

Controller ID Displays the Control Box ID. Make sure to set the Control Box 
ID Switch on the rear of the Control Box using the ID displayed 
here so that the project file will be uploaded to the controller set 
with the same ID.

ATEN Controller Type Select the controller model you are installing. 
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Number of Rooms Enter the number of rooms each controller will control. Each 
hardware device you add will be associated with a room. When 
buttons are configured in the Design tab, you can select a 
Room under Button Action to filter the Device list so that only 
hardware in that room appears. This link between the 
controller, devices and room is how the Viewer knows which 
devices to control.

Name Enter the client name associated with the project.

Address Enter the client address associated with the project. 

Phone Enter the client phone number associated with the project. 

Remove Controller Click to delete a controller from the project.

Start Project Click to begin configuring hardware devices. The Select Device 
& Configuration tab will open. 

Control Description
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Device

The Device tab is used to configure controller ports according to the connected 
hardware device. 

Control Description

Device 
Configuration 
List

This section lists the ports for each controller. Select a Controller, 
Expansion Box or Room in the left sidebar to display the ports. Each 
port needs to be configured according to the hardware device 
connected to it. For details, see Device Configuration List, page 85.

Left Sidebar This section lists the Controllers, Expansion Boxes and Rooms. Use 
the sidebar to add a controller, Expansion Box or Room. When a port 
is configured with a device, the device appears listed below the room 
on the sidebar. For details, see Left Sidebar, page 88.

Properties This section allows you to add and configure controllers, Expansion 
Boxes, managed devices, and rooms. For details, see Design, 
page 100.

Device Library Click this icon to open the Library on the Device Library tab which 
contains a database of hardware devices that can be added to the 
Device Configuration list. For details, see Device Library, page 99.
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Device Configuration List
The Device Configuration page lists the controller ports by type. Click a port 
to view its Properties (page 88). Double-click a port to open the ATEN 
Device Library and search for the hardware device to configure the port. 
Configure each port according to the hardware device connected to it.

Control Description

Type Lists the ports of the controller.

Device Lists the device name entered in Properties. 

Mode Lists the port’s communication mode. Click an arrow to select options:

Serial: RS232, RS422, or RS485

I/O: Input (VDC), Input (Dry Contact) or Output

IR: IR or RS232

Room Lists the room selected for a device. The rooms available depend on the 
number of rooms added to the controller. No drop-down menu appears 
if there is only one room. Each controller must have at least one room. 
Select the room where the device is installed. 

+ Add More 
Devices

RS422, RS485, LAN and IR ports can cascade additional devices that 
are connected to the first unit. IR ports can cascade 1 device, RS422 
and RS485 ports can cascade up to 2 devices and LAN ports can 
cascade up to 25 devices.
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Adding Devices to ATEN Configurator

Add the devices to be managed by your ATEN controller to the Device 
Configuration list and configure their settings.

To add KNX devices, follow the steps below:

1. Click File and then Import ETS Project. The configurations for your 
KNX devices appear in the Controller tab on the left-side bar.

2. In the Controller tab, click on KNX IP Interface and type its IP address 
and port in the Properties column.

To add devices that are not KNX compliant, use one of the following 
methods:

Add devices using ATEN Device Library or My Library
1. In the Device Configuration list, click a port where you have 
physically installed a device.

2. Click  library. In the pop-up window, click the drop-down list to 
select ATEN Device Library or My Library, and then double-click an 
item to add a device. The selected device is added to Device 
Configuration.
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Add devices using the Properties column
Type the name of the device in Properties, and then click Add Device.

Note:If the device is not in the Library, create the device using Database 
Generator. For details, see Edit / Add New Device, page 189.
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Left Sidebar
Controller
The Left Sidebar provides a tree view of the 
controllers, Expansion Boxes, and rooms. Each 
controller in the tree view represents a controller with 
one or more rooms it manages. Selecting a controller 
allows you to configure its ports. When a port is 
configured for a device, it appears listed under the 
Room. 

Each controller must have at least one room. When 
installing multiple controllers in one room, add a room 
with the same name to each controller. 

Each controller name ends with an ID number: 
VK2100-ID01. Use this number to set the Controller 
ID Switch on the rear of the controller. This links the 
controller in the software to the physical device being 
installed.

Right-click a controller to Add Room or Delete 
Controller.

Room
Each room is associated with a controller and a 
Viewer so that the information is uploaded to the 
correct controller to control the hardware devices. 

Right click a room to Delete or Rename the room.

Use the buttons at the bottom of the sidebar to Add 
Room. 

Expansion Box
ATEN Expansion Boxes connect over a network to 
add ports to the controller via its Ethernet port. 
Clicking Add Controller or Expander opens a 
window which allows you to select a device to add:
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Properties
The Properties panel provides information and configuration fields for 
controllers, Expansion Boxes, remote devices, or rooms. Click a device or room 
from the left sidebar or the Device Configuration list to display its properties.

Controller Properties
Click a controller from the left sidebar or the 
Device Configuration list to configure the 
following properties.

Name: Type to change the device name.

Controller ID: Sets the controller ID. 
ATEN Expansion Box and Keypad will 
connect to a controller with a matching 
controller ID as set on the Expansion Box 
or Keypad using the Controller ID Switch. 

Identify ATEN Expansion Box and Keypad by IP Address: 

Note: Only enable this function if any of the following scenario applies.
Need to install more than 16 controllers under the same subnet.
Your network switch blocks multicast signals between the controller and 
Expansion Box/Keypad.

When enabled, the controller connects to an ATEN Expansion Box/Keypad 
with matching controller ID and Expansion Box/Keypad IP address. 

To use this function, make sure to do the following.

On the Expansion Box/Keypad:

Set the controller ID using the Controller ID Switch. When you 
have more than 16 controllers under a subnet, at least two of the 
Expansion Boxes and/or Keypads will be assigned with the same 
controller ID.
Set the Expansion Box/Keypad to a fixed IP address.

In the project files:

In the Devices tab, make sure the controller IDs match the 
configuration on the Expansion Boxes and/or Keypads.
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In the Devices tab, enable the Identify ATEN Expansion Boxes 
and Keypads by IP address function the Properties panel. For 
example, if you have 17 controllers set up under the same subnet, 
with controller 1 and 17 using ID01, enable the function for both of 
these controllers.
Specify the IP address of the Expansion Box/Keypad.

sdfFor Keypad, go to Design > Viewer Settings.

sdfFor Expansion Box, go to Devices and find the Properties panel.

Port: Specify the port to allow TCP communications from third-party client 
devices.
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Expansion Box (Expander)
When you select an Expansion Box from the left side bar, the properties 
provides a drop-down menu to set the Expander ID (ID01~ID08) and the option 
to configure the IP Address. 

To add an Expansion Box, click Add Controller or Expander on the left 
sidebar, then use the arrow and select an ATEN Expansion Box to add. The 
expansion box and ports will be listed on the Device Configuration page, as 
shown below: 
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Serial Device Properties
Click a serial device from the Device 
Configuration list to configure its 
properties. 

Name: Type to set the device name.
Add Device: Adds devices. You can use 

either of the following methods to add 
devices:

Type the device name in the Name field 
and click Add Device.

Click the arrow button (following the Add 
Device button) and select add device 
from library to open the device library. 
Double-click a device to bring in its 
information and settings.

Category: Displays the category of the 
selected device.

Brand: Displays the brand of the 
selected device.

Model: Displays the model of the 
selected device.

Version: Shows the firmware version 
selected for the device. Use the drop-
down menu to select a different firmware 
version. Click the menu box next to the 
version number to open a PDF with the 
version history. The version history and 
different versions for a device can be 
manually added/updated via the Database 
Generator (see step 3 of Edit / Add New 
Device, page 189).

Connection Settings: Click the drop-
down lists to configure the baud rate, data 
bit, stop bit, parity settings, and flow 
control for the selected serial device.

Advance Settings: Click Advanced to 
display the following settings.
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Delay Interval: Sets a time delay for each command before they are 
sent to the device.
Feedback Timeout: Sets the maximum interval that the controller 
allows in between parts of a feedback message. The controller uses 
this value to identify the end of a message.
Keep Connection Alive: The controller sends a command to the serial 
device to maintain the connection and avoid timeout issues.

Command: Type a command to be sent to the selected device.

Interval: Type the interval at which the controller sends the 
command.
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I/O Device Properties
Click an I/O device from the Device 
Configuration list and select Input 
(VDC), Input (Dry Contact), or Output 
to configure its properties. 

Name: Type to set the device name.
Add Device: Adds devices. You can 

use either of the following methods to 
add devices:

Type the device name in the Name 
field and click Add Device.

Click the arrow button (following the 
Add Device button) and select add 
device from library to open the device 
library. Double-click a device to bring in 
its information and settings.

Category: Displays the category of 
the selected device.

Brand: Displays the brand of the 
selected device.

Model: Displays the model of the 
selected device.

Version: Shows the firmware version selected for the device. Use the drop-
down menu to select a different firmware version. Click the menu box next 
to the version number to open a PDF with the version history. The version 
history and different versions for a device can be manually added/updated 
via the Database Generator (see step 3 of Edit / Add New Device, 
page 189).

Lower Threshold & Upper Threshold: Set the thresholds according to the 
hardware device you are connecting and then configure a Monitor (see 
page 155).

Advance Settings: Click Advanced to display the Delay Interval setting.

Delay Interval: Sets a time delay for each command before they are 
sent to the device.
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IR/Relay Device Properties
Click an IR/Relay device from the Device 
Configuration list to configure its 
properties. 

Name: Type to set the device name.
Add Device: Adds devices. You can 

use either of the following methods to 
add devices:

Type the device name in the Name field 
and click Add Device.

Click the arrow button (following the 
Add Device button) and select add 
device from library to open the device 
library. Double-click a device to bring in 
its information and settings.

Category: Displays the category of the 
selected device.

Brand: Displays the brand of the 
selected device.

Model: Displays the model of the 
selected device.

Version: Shows the firmware version selected for the device. Use the drop-
down menu to select a different firmware version. Click the menu box next 
to the version number to open a PDF with the version history. The version 
history and different versions for a device can be manually added/updated 
via the Database Generator (see step 3 of Edit / Add New Device, 
page 189).

Advance Settings: Click Advanced to display the Delay Interval setting.

Delay Interval: Sets a time delay for each command before they are 
sent to the device.
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Ethernet Device Properties
Click an Ethernet device to configure its 
properties. Each Control Box supports up 
to 25 Ethernet devices, and each Control 
Pad supports up to 8.

Name: Type to set the device name.
Add Device: Adds devices. You can 

use either of the following methods to 
add devices:

Type the device name in the Name field 
and click Add Device. 

Click the arrow button (following the 
Add Device button) and select add 
device from library to open the device 
library. Double-click a device to bring in 
its information and settings.

Category: Displays the category of the 
selected device.

Brand: Displays the brand of the 
selected device.

Model: Displays the model of the 
selected device.

Version: Shows the firmware version 
selected for the device. Use the drop-
down menu to select a different firmware 
version. Click the menu box next to the 
version number to open a PDF with the 
version history. The version history and 
different versions for a device can be 
manually added/updated via the 
Database Generator (see step 3 of Edit / 
Add New Device, page 189).

Connection Settings
Depending on the selected protocol, some of the following settings may not 
be required and are not displayed. 

Protocol Type: Click to select the protocol for the Ethernet device. The 
ATEN Control System supports control of devices via telnet, ONVIF, 
TCP, UDP, HTTP, and HTTPS.
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IP Address: Type to assign a fixed IP address to the Ethernet device.

Port: Type to assign a communication port.

Username & Password: Type to set up the login/access credentials for 
the device.
Auth Type: Sets the authentication type that the device uses. 

Advance Settings: Click Advanced to display the Delay Interval setting.

Delay Interval: Sets a time delay for each command before they are 
sent to the device.
Delay after Login (for telnet only): Sets a delay (to allow a connection 
to be established) before the First and Second Commands are sent to 
the device. 
Send command after connection (for telnet and TCP only): Sends 
commands to the device after a successful connection has been 
established. 

Format: Sets the command format.

First Command: Sets the command.

Second Command: Sets the second command.

Automatically reconnect if no return message is received: 
Select this option to continue reconnection attempts when no 
return message is received from the device.

Keep Connection Alive (for telnet and TCP only): The controller 
sends a command to the device to maintain the connection and avoid 
timeout issues.

Command: Type a command to be sent to the selected device.

Interval: Type the interval at which the controller sends the 
command.
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Library
The Project Bar provides the Library option. Use the Device Library 
tab (shown below) to configure controller ports according to the 

connected hardware devices. The Device Library provides an extensive 
database of hardware devices that can be double-clicked or drag and dropped 
into the Device Configuration page to configure controller ports. The Device 
Library is discussed on the next page.
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Device Library
The Device Library tab is a database of hardware devices that instantly 
configure controller ports. Search the library for the device connected 

to a controller port then add it to configure the port. For devices not in the 
library, use the ATEN Database Generator to create custom hardware (see 
page 185). Click Library on the Project bar or double-click a port on the 
Device Configuration page to open the ATEN Device Library. 

Add a device by clicking Add to Project or by drag & drop. 

To search for a device type keywords into the box and click .
Click a tab to filter by All, Serial, DO, IR, Relay or Ethernet.
Click headings to sort by Brand, Device Type, Model or Version.
Use the drop-down menu to select:

ATEN Device Library – ATEN’s database of hardware devices. 
My Device Library – Devices added from the Database Generator.
Create Device – Opens the Database Generator to create custom 
hardware devices for My Device Library (page 186).
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Design

Overview
The Design tab is for creating a Viewer – the user interface that controls the 
hardware from a mobile device or Keypad. Create a Viewer and add the pages 
to control the hardware according to the setup you are installing. 

Element Description

Left Sidebar The left sidebar lists each Viewer and its pages.The sidebar allows you 
to add Viewers and pages. These options become available after 
clicking Done on the Viewer Settings page. For more details, see Left 
Sidebar, page 88.

Select Viewer The Select Viewer section allows you to configure the basic settings 
and type of Viewer you want to create. See Left Sidebar, page 101, for 
details.

Library Click this icon to open the Library which provides access to the 
Graphic (page 150), Flag (page 153), Monitor (page 155), Macro 
(page 173), Scheduled Event (page 175), and Variable settings 
(page 176).

Simulator The Simulator button is used to test a Viewer’s interface after it has 
been created. The simulator allows you to tryout the interface as it 
would work on a mobile device but without actually controlling devices. 
Use the mouse to click through the page links.
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Left Sidebar

Viewer
The Left Sidebar provides a tree view of the 
Viewers and Pages. Clicking a Viewer opens the 
Page Overview which is a layout of the Viewer. 

Right-click a Viewer to Delete, Rename or Edit the 
Viewer. 

Use Add Viewer at the bottom of the sidebar to 
create a new Viewer. 

Pages
Each Viewer lists the Home Page with each 
Viewer Page created for the Viewer under it. 

Clicking a Home or Viewer Page on the sidebar 
opens a new tab where the page can be edited.

Right-click a page to Delete, Rename, or Copy the 
page and paste it to another Viewer within the 
same or a different project file. The Copy function 
replicates the page’s visual design without its 
configurations.

The Home Page cannot be deleted.

Use Add Page at the bottom of the sidebar to add 
a page to the Viewer. 
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Adding a Viewer
A Viewer is a control interface that you use on mobile devices, ATEN 
Keypads, or ATEN Control Pads to centrally control devices and equipment. 
Use the Select Viewer page to select a Viewer template for your device type. 

To add a Viewer and/or its associated control pages, follow the steps below.

1. In the Configurator, go to the Design tab. This screen appears. If the Select 
View page does not appear, click Add Viewer from the left sidebar.

2. Select your device type.
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3. Configure the displayed settings for your selected device. 

Mobile Device

Keypad

Setting Description

Type Use this drop-down menu to select the mobile device that 
will be used to control hardware devices in a room. This sets 
the resolution for the Viewer to fit on the mobile device’s 
screen. 
Choose a Custom selection to configure a screen size with 
the Resolution drop-down menu below it.
Note: If you select Custom Windows Device – the Windows 
OS has a limitation for adding buttons to Viewers used on 
Windows mobile devices. See Windows OS Button 
Limitation, page 246, for details. 

Resolution Use this drop-down menu to set a custom screen resolution 
for the mobile device being used to control hardware 
devices. This option becomes available when you select one 
of the Custom selections from the Type drop-down menu. 

Display Aspect 
Ratio

Indicates the aspect ratio used for the selected device.

Home Page Select a template for the Viewer’s home page.
Blank: Creates a custom home page that you design from 
scratch.
ATEN Themes: Select any of the ATEN Themes to create 
a home page and other device pages with graphics. 
These pages are customizable.

Setting Description

Model Specify the Keypad model.

Number of Keys Specify the total number of keys for your Keypad.

Layout Specify the Keypad layout. This setting should match the 
physical Keypad layout (see page 53 for details). Depending 
on the total number of keys the Keypad has, you may have 1 
or multiple options for this setting.

Controller ID Select the ID number of the Control Box (Controller) that the 
Keypad will connect through. This ID must match the 
controller ID Switch (black) set on the Keypad (see 
page 52).
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Control Pad

Keypad ID Select the ID number to match the Keypad ID Switch 
(blue) set on the Keypad (see page 52). Up to 8 
Keypads can connect to one Control Box.

(Optional) Type the IP address of the Keypad with which 
the controller uses to identify and establish connection. 
Use this feature when you have more than 16 ATEN 
Expansion Box and/or ATEN Keypad in the project or 
when the network switch blocks multicast signals 
between the Keypad and the controller.

Add Keypad Click Add Keypad to add another Keypad that will connect 
to the same Control Box and control the same set of 
devices. 

Setting Description

Model Specify the model for the Control Pad.

Number of Keys Specify the total number of keys for your Control Pad.

Layout Specify the layout for the Control Pad. This setting should 
match the physical layout (see page 53 for details). 
Depending on the total number of keys the Control Pad has, 
you may have 1 or multiple options for this setting.

Controller ID Displays the Control Pad ID.

Setting Description
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4. Click Done to save the configuration. An overview appears showing all 
the control pages that the selected Viewer has.

5. (Optional) Add, edit, or remove the pages or adjust the basic settings of the 
Viewer.

Control Description

Click to duplicate the Viewer along with the pages.

Click to edit the basic Viewer settings that you configured in step 
3.

Click to add a page to the highlighted Viewer in the left sidebar.

Click to configure the page. For more information, see 
Configuring the Viewer, page 106.

Click to remove the page.



ATEN Control System User Manual

106

Configuring the Viewer
After you have added the Viewer and the associated pages, you are ready to 
configure the page layout and object actions, for example, button actions in the 
Viewer.

To configure a Viewer, follow the steps below.

1. Use one of the following methods to open the page you wish to configure. 
Click the page from the left sidebar.

Click its associated Viewer from the left sidebar and then click  to 
open a page.

The page opens in a tab. For example:

2. To add more control objects on the page, right-click on the preview, and 
select an option from the pop-up menu. 

Note: The Windows OS has a limitation when adding buttons to Viewer 
pages for use on Windows mobile devices. See Object Properties, 
page 109, for details.
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3. Click the element in the preview panel to customize the settings. See the 
table below for more information.

Element Tasks

Preview panel Shows a preview of the selected page. You can also do 
the following on the preview panel:

To zoom in and out on the preview, scroll the 
mouse wheel.
To relocate an object, drag and drop the object.
To layer an object, right-click the object and set 
the Order options.
To group multiple objects, drag the mouse to 
select the objects, right-click on any of the objects 
and select Group.
To align object, drag the mouse to select the 
objects, right-click on any of the objects and select 
Align.
To set objects in perfect alignment, use the View 
menu options to select Show Grid and Align to 
Grid.
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Properties panel Use the panel to configure selected object properties. 
For detailed information about object properties, see 
Object Properties, page 109.

Library Use Library to customize the appearance of the page 
and its buttons. For more information, see Library, 
page 98. 

Button Action or 
Slider Bar Action

Use this panel to define the functions of each button 
and slider bar. For detailed information, see Button / 
Slider Bar / Dial Kit Actions, page 127.

Advanced 
functions

To add additional conditions and actions to 
buttons, use the Flag function. For more 
information, see Flag, page 153.
For a button to initiate a sequence of actions, 
create a Macro. For more information, see Macro, 
page 173.

Element Tasks
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Object Properties

This section provides detailed information about properties of control objects 
on the Viewer. Note that the supported objects and their functions may differ 
among Viewers for mobile devices, Keypad, and Control Pad.

Page Objects
A number appears at the top right corner of each object. The numbers are 
assigned in sequence, in the order that the object is added. These numbers help 
identify a label when configuring a Change Label (page 144) or a button when 
configuring a Change Button State (page 143). 

Each button has a symbol in the top left corner to indicate: 
“A” the button’s actions are configured correctly. 
“!” the button’s actions need to be modified or they will not work. 
Buttons with no symbol indicate that functions have not been added to it. 
For details on adding functions, see Button / Slider Bar / Dial Kit Actions, 
page 127. 
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Object Properties for Mobile Devices
After you have added a Viewer (page 102) for your mobile device, you can 
start configuring the pages that the Viewer contains in the Properties panel. 

Buttons

The Button properties provide options to configure the appearance of a button, 
and the confirmation message and progress message before carrying out the 
associated action. 
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Alignment – Aligns a group of objects. Select multiple objects for the 
buttons to become available:

Mode 
Use this drop-down menu to select one of the following button types. 

Normal – This is a button that stays the same when pressed.
Toggle – for a button that switches between two images/colors to 
indicate the button status. This also splits the Commands list under 
Button Action (page 127) – to provide two commands for the button: 
Toggle ON and Toggle OFF. 
Press and Release – for a button that switches between two images/
colors when pressed and released.This splits the Commands list under 
Button Action (page 127) to provide two commands for the button: 
Press and Release. 
Long Press for a button that switches between two images/colors 
when pressed and released. This button continuously re-sends a 
command to a device as long as it is pressed, at the Interval specified 
(see Interval, below) and stops sending the command once the button 
is released. 

Note: Use the Normal or Long Press option to set the image/color of the 
button based on its status.

Appearance
Click the Appearance tab to configure the look of the button.

Note: The Appearance settings are applicable to all button modes. 
However, the Appearance tab only exists for Normal and Toggle buttons 
to categorize different sets of settings.

Name – (optional) type the text you want to use for the button (or slow 
double-click the button on the Viewer page).
Font – use the drop-down menu to select the font type. 

Color – use the drop-down menu to change the color of the text.
Size – enter a number (1-200) to set the size of the text for the 
button.
Format – formats text to Bold, Italic or Underline for the button. 
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Alignment – click a box to align the text Right, Center or Left; 
and Top, Middle or Bottom within the button box.

Style – use the drop-down menu to select the style type. 
Normal imports an image to use as the button’s standard 
background and click Pressed to import an image to use when the 
button is pressed.
Color allows you to use drop-down menus to select the buttons 
color for Normal and Pressed. 
Transparency – enter a number (0-100) or use the slider-bar to 
set the transparency of the button.

Send Command Every (Long Press mode buttons only) – use the 
drop-down menu to select the amount of time between each command 
that is sent (repeatedly) to the device while the button is pressed.
Position and Size – X and Y position the button at the coordinates 
entered. Width and Height set the size of the button box. Click Reset 
Image Size to reset the button size.

Reset Image Size – click to reset the button size.
Set Sync Condition – automatically synchronizes the button 
setting to the selected variable. To create variables, see Variables, 
page 176.

Restrict access to this button on ATEN Control System App with a 
password: Limit the use of the selected button by requesting a 
password when the button is tapped in the Viewer. To enable this 
function, click this option and type the password in the box below. 

Note: This function is only supported by the Normal and Toggle mode 
buttons (page 111).

Dialog
Click the Dialog tab to set up a confirmation message that displays in the 
Viewer when the button is pressed. 

Note: The Dialog settings are only available for Normal and Toggle 
buttons. 

Confirm the associated action with the following message when the 
button is pressed – Click the check box to enable this feature.
Action – Select a button action (Toggle On or Toggle Off) to display 
the confirmation message.
Content drop-down list – Select one of the following for 
customization.
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Background – Customize the wording for the confirmation 
message. Type the message in the Name field and optionally 
customize its font and style.
OK – Customize the wording on the button for carrying out the 
associated action. Type in the Name field and optionally 
customize its font and style.
Cancel – Customize the wording on the button for canceling the 
associated action. Type in the Name field and optionally 
customize its font and style.

Message
Click the Message tab to set up a progress message that displays while the 
associated action is being carried out.

Note: The Message settings are only available for Normal and Toggle 
buttons. 

Confirm the associated action with the following message when the 
button is pressed – Click the check box to enable this feature.
Action – Select a button action (Toggle On or Toggle Off) for 
displaying the progress message.
Content drop-down list – Select one of the following for 
customization.

Background – Configure the wording for the progress message. 
Type the message in the Name field and optionally customize its 
font and style.
Progress Bar – Configure the display duration (in seconds), font, 
and color of the progress indicator.
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Groups

You can unify the properties of two or more control components (buttons, 
slider bars, etc.) at the same time. Depending on the elements that your group 
of components have, different properties will be open for configuration.Use 
your mouse to drag and select the components from a page, the properties that 
are open for configuration appear in the Properties column. 

For example, if you want to unify the text that appear on multiple buttons, drag 
and select these buttons and then configure their properties, as illustrated 
below.
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Labels

The Label properties provide settings for 
the displayed text and its format. 

Alignment – Aligns a group of objects. 
Select multiple objects for the buttons to 
become available:

Name – enter the text you want to use 
for the label or slow double-click the 
label on the Edit page.

Font – use the drop-down menu to 
select the font type. 

Color – use the drop-down menu to 
change the color of the text. 

Size – enter a number (1-200) to set the 
size of the text.

Format–  format text to Bold, Italic or 
Underline.

Alignment – click a box to align the 
text Right, Center or Left; and Top, 
Middle or Bottom within the label box.

Border/Line – select this option to 
configure the color, format, and width of 
the display screen border.

Position and Size – X and Y position the label at the coordinates entered. 
Width and Height set the size of the label. 
Set Sync Condition – Displays the value of the selected variable in 
percentage or its raw form. To create variables, see Variables, page 176. 
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Slider Bars
Right click on a Viewer page and select Slider Bar to add a bar. A Slider Bar 
can control a device, link to another page, or run a macro.
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Use the Mode drop-down menu to select the type of slider bar (Basic Slider 
Bar or Advanced Slider Bar).

Basic Slider Bar
A slider bar where you enter the minimum and maximum values to 
calculate the range and levels on a slider bar, and then add one command 
to configure the Basic Slider Bar’s action (See Slider Value, page 133). 
Choose options under Value to configure the slider bar’s range.
Direction – sets the bearing of the slider bar. 
Style – click the drop-down menus to select the Foreground Color and 
Background Color for the slider bar.
Value – Sets the total number of levels for the slider bar.

ASCII / HEX – click a radio button to select the format for the slider 
bar values. 
Minimum – enter the lowest level on the bar.
Maximum – enter the highest level on the bar. 
Level – this represents the number of levels on the slider bar. You can 
calculate the value of each level with the formula: Maximum Value - 
Minimum Value / Level = Value Per Level. The Level is 
automatically calculated according to the Minimum and Maximum 
values you enter. 

Position and Size – depending on whether the bar is set Vertical or 
Horizontal you can use either the Size: Width or Height box to enter a 
number to resize the length of the slider bar. 
Set Sync Condition – Automatically synchronizes the slider bar to the 
selected variable. To create a variable, see Variables, page 176. 

Advanced Slider Bar 
A slider bar where you set the number of levels and add a command for 
each level in the bar (see Level, in the table, on page 127). Choose options 
under Value to configure the slider bar’s range:
Direction – sets the bearing of the slider bar. 
Style – click the drop-down menus to select the Foreground Color and 
Background Color for the slider bar.
Value – Sets the total number of levels for the slider bar.Level – this 
represents the number of levels on the slider bar. For each level you must 
add a separate command in the Slider Bar Action – Commands list (see 
Level, in the table, on page 127). 
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PowerPoint Control and Media Control Templates

Click a PowerPoint control template or a media control template to configure 
its position, size, and the PC that controls it.

Position and Size – X and Y position the label at the coordinates entered. 
Width and Height set the size of the label. 
Select Device – Select the PC that stores the PowerPoint or media files 
using the drop-down list.
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Image

The Properties for an image provide options to change and import images to 
the page. Images can be layered with other objects so that they can be placed 
as a background or as highlights for buttons (see Layering Images, page 120). 
You can Group, Order, Align, Make Same Size or Space Evenly from the 
Object menu. 

Note: For imported images, make sure the file names contain English alphabets 
and/or numerals only.

Style – shows the image selected. Click inside the box to import an image 
(*.png,*.jpg,*.jpeg,*.bmp) to the page.
Transparency – enter a number (0-100) or use the slider-bar to set the 
transparency of the image selected.
Position and Size – X and Y position the image at the coordinates entered. 
Width and Height set the size of the image. 
Reset Image Size – resets the image size. 
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Layering Images

Images can be layered with other objects, such as labels and buttons, so that 
they can be placed as a background or as highlight for the page and/or other 
objects.
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Dial Kit

A dial kit template consists of a display screen and a set of dial keys. To 
configure their appearance, click on the display area or a key. 

Display Screen

Dial Keys

Properties for Display Screen Properties for Dial Key
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Font – use the drop-down menu to select the font for the typed text. 
Color – use the drop-down menu to change the color of the text.
Size – enter a number (1-200) to set the size of the text for the button.
Format – formats text to Bold, Italic or Underline for the button. 
Alignment – click a box to align the text Right, Center or Left; and 
Top, Middle or Bottom within the button box.

Style – use the drop-down menu to select the style type. 

Note: The image and color settings are only applicable to dial keys.

Image – select this option to import different images for the dial key 
when it is pressed and not pressed (normal). 

Transparency– enter a number (0-100) or use the slider-bar to set 
the transparency of the button.

Color – select this option to use different color blocks to indicate a 
pressed and a normal dial key. 
Border/Line – select this option to configure the color, format, and 
width of the display screen border.

Position and Size – X and Y position the button at the coordinates entered. 
Width and Height set the size of the button box. Click Reset Image Size to 
reset the button size.

Note: If you are using the Call  and End Call  dials, click the dial key 
to configure its action. For a detailed procedure, see Example 1: Configuring 
actions of dial keys., page 134.
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Frame & Line

Use frames and lines to visually group or separate control objects in your 
Viewer. Click a frame or line object to configure its properties.

Style – configure the color, format, and width of the line or border of the 
frame.
Rounder corder – use the scroll bar or the number box to configure the 
roundness of the frame corner.
Fill – select this option to fill the frame with the selected color.
Position and Size – X and Y position the frame/line at the coordinates 
entered. Width and Height set the size of the frame/line. 

Frame Properties Line Properties
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Object Properties for ATEN Keypad / Control Pad
After you have added a Viewer (page 102) for your Keypad / Control, you can 
start configuring the Viewer. In the Viewer page, click on a button to configure 
its settings. The following settings appear in the Properties panel.
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Mode 
Use this drop-down menu to select one of the following button types. 

Normal – This is a button that stays the same when pressed.
Toggle – for a button that switches between two images/colors to 
indicate the button status. This also splits the Commands list under 
Button Action (page 127) – to provide two commands for the button: 
Toggle ON and Toggle OFF. 
Press and Release – for a button that switches between two images/
colors when pressed and released.This splits the Commands list under 
Button Action (page 127) to provide two commands for the button: 
Press and Release. 
Long Press for a button that switches between two images/colors 
when pressed and released. This button continuously re-sends a 
command to a device as long as it is pressed, at the Interval specified 
(see Interval, below) and stops sending the command once the button 
is released. 

Note: Use the Normal or Long Press option to set the image/color of the 
button based on its status.

Name – (optional) type the text you want to use for the button (or slow 
double-click the button on the Viewer page).
Font – use the drop-down menu to select the font type. 

Color – use the drop-down menu to change the color of the text.
Size – enter a number (1-200) to set the size of the text for the button.
Format – formats text to Bold, Italic or Underline for the button. 
Alignment – click a box to align the text Right, Center or Left; and 
Top, Middle or Bottom within the button box.

Style – use the drop-down menu to select the style type. 
Image – imports an image to use as the button’s standard background 
and click Pressed to import an image to use when the button is pressed.
Color – allows you to use drop-down menus to select the buttons color 
for Normal and Pressed. 
Transparency – enter a number (0-100) or use the slider-bar to set the 
transparency of the button.

Send Command After Holding – Sets the required time for holding the 
button to apply the action for which the button is configured.
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Position and Size – X and Y position the button at the coordinates 
entered. Width and Height set the size of the button box. 
Set Sync Condition – Automatically synchronizes the button to the 
selected variable. To create a variable, see Variables, page 176. This 
option is only available for toggle buttons.
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Button / Slider Bar / Dial Kit Actions

Understanding Button/Slider Bar/Dial Kit Actions
After you have added a button, slider bar, or a dial kit on your Viewer, define 
the actions it initiates using the Button/Slider Bar Actions panel. To access the 
panel, click on a button, slider bar, or dial key in the Viewer. The Button/Slider 
Bar Action panel appears.

The Button/Slider Bar Actions panel consists of the following elements:

Setting Description

Device Lists the added devices and the advanced functions. 

Room Select the room that contains the devices the Viewer will 
control. Use this drop-down menu to select rooms in the KNX 
system and display KNX devices. The Viewer will only upload 
to a controller configured with the same Room name (see Left 
Sidebar, page 88). Select All Rooms to allow the Viewer to 
control all rooms. Selecting All Rooms will upload the Viewer 
to all controllers. 
The Accessible Room defines what Devices are available to 
configure new Actions in Button/Slider Bar Properties (see 
page 127). Only Devices listed under the same Room (see 
page 88) as the Viewer’s Accessible Room will be listed for use 
in Button/Slider Bar Properties. 

Function Lists the supported functions for your chosen device or 
advanced option. Double-click a function to add it to the 
Command List, which shows a sequence of tasks to be executed 
when specified conditions are met for the button, slider bar, or 
dial key. For details on functions, see Functions, page 130.
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You can configure a button with Device commands (On, Off, Stop, Play, etc.); 
as a Macro to send multiple commands to one or more devices; or as a Link 
to other Viewer pages. Advanced Options allow you to add conditions to the 
commands, as described on the next page. 

Commands Lists the commands that initiate when the button or dial key is 
pressed. Device and Advanced Option functions can be added 
and associated in the Commands list together. Commands 
initiate in the order that they are added to the list. Right-click in 
the Commands list to use the menu selections: Move Up, Move 
Down, Copy, Paste, Delete, Save as Macro, or Test Tool. 

Toggle ON / 
Toggle OFF
or 
Press / Release

When the Button Mode (page 111) is set to Toggle or Press and 
Release, the Commands list splits to set the two c commands:
Toggle ON / Press – lists the commands that initiate when the 
button is first pressed or pressed and held.
Toggle OFF / Release – lists the commands that initiate when 
the button is pressed a second time (Toggle), or released (Press 
and Release). When the button is pressed again, Toggle ON 
initiates and the cycle repeats.

The Level drop-down menu appears when an Advanced Slider 
Bar is selected on the Viewer page. The number of levels in the 
drop-down menu reflect the Level set in the Advanced Slider 
Bar’s properties (page 117). Use the drop-down menu to select a 
level and then add a command for each of the Advanced Slider 
Bar’s levels (see page 133 for details).

Use Move up to move an action up in the Commands list, or 
Move down to move an action down in the Commands list. 

Use Delete to remove an action from the Commands list. 

Use Save as Macro to save the commands in the Commands 
list as a macro. 

Use Test Tool to connect to a controller and test the action(s) in 
the Commands list. 

Setting Description



Chapter 4. ATEN Configurator (VK6000)

129

Configuring Button/Slider Bar Actions
To add one or more actions to a button, slider bar, or dial key, follow the steps 
below.

1. In the project file, click to select the button, slider bar, or dial key in the 
Viewer. The Button/Slider Bar Action panel appears.

2. In the Button/Slider Bar Action panel, select a Room.

3. Add commands. 
For details on device functions and advanced functions, see Functions, 
page 130.

a) Click a device or an advanced option to display its supported functions.

b) Double-click a function to add it to the Commands list.

c) Repeat step 3a and 3b if you wish to initiate a sequence of actions.

4. In the Commands list, double-click the commands to configure them. 
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Functions
Button/slider bar functions can be understood as device functions and 
advanced functions.

Device functions – These are functions that the selected controller or a 
device managed by the controller initiates. The supported device functions 
vary depending on the device you select in the Device list, as illustrated 
below. For details on controller functions, see Device Functions, page 132.
Controller functions

VM3404H functions
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Advanced functions – These are functions that involve more than one 
devices in the project. Use the indicated column to select an advanced 
function, the available options are listed in the Function list. For details 
about each advanced function, see Advanced Functions, page 135.
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Device Functions
Each ATEN controller supports the following functions.

Delay – adds a delay in seconds. Enter a number between 0.1-180. 
Relay – adds an Open, Close, Toggle or Pulse action on the selected 
controller and Relay port. 
DO – adds an Open, Close, Toggle or Pulse action on the selected 
controller and Digital Output port. 
Wake on LAN – powers on the specified computer (MAC address) 
over Ethernet.
Serial Raw (ASCII) – adds a serial command in the ASCII mode.
Serial Raw (HEX) – adds a serial command in the HEX mode. 
Telnet Raw (ASCII) – adds a telnet command in the ASCII mode.
TCP Raw (ASCII) – adds a TCP command in the ASCII mode. 
TCP Raw (HEX) – adds a TCP command in the HEX mode. 
UDP Raw (ASCII) – adds a UDP command in the ASCII mode.
UDP Raw (HEX) – adds a UDP command in the HEX mode.
HTTP – adds an HTTP command.
HTTPS – adds an HTTPS command.

Value Types
When a device command has multiple values you can double-click it and 
use the Show Flag Menu* to select a device setting:

 Library Value – use the drop-down menu to select 
a device setting for the command. The selection of settings in the drop-
down menu can be modified using the Database Generator to edit the 
command string (see Edit / Add New Device, page 189).

 Flag Variable – clicking this button allows a Flag 
with a set of values to be selected for the action. The button’s action 
will select a setting according to the Flag value. Each value in a Flag 
can be set to a different device using a Set Flag (as a button to select 
the device). When that (Set Flag) button is pressed, the Flag value is 
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set for that particular device, and will be used as the setting for this 
action, when it’s button is pressed. 

 Variables – Select this option to use a Variable in 
the command. After selecting the option, a drop-down menu 
containing a list of the Variables that you created appear. 

 Slider Value – select this option to configure a Basic 
Slider Bar’s command. The range and change levels are automatically 
configured according to the minimum and maximum values set for the 
Basic Slider Bar. This option only appears when a Basic Slider Bar is 
selected on the Viewer page and you are adding Slider Bar Action 
commands. 

Note: The Show Flag Menu allows you to use a single Flag for all devices 
rather than adding a Conditional Flag for each device.

 Dial Value – select this option to use the string of 
values that has been dialed using the dial kit via Viewer from a mobile 
device. 

 Level – When an Advanced Slider Bar is selected on a 
Viewer page, the Level drop-down menu appears above the Commands 
list. A command must be added to each level of an Advanced Slider 
Bar. To configure each level, use the drop-down menu to select a level 
and then add a command to it.
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Applications of Device Functions

Example 1: Configuring actions of dial keys.

Out of the 15 keys on a dial kit, only the Call  and End Call  keys require 
configuration, the actions for other keys are pre-configured to send out the 
number or character as indicated on the keys. 

Follow the steps below to add an action to the Call key.

1. Click the Call key  in the Viewer to display the Button Action panel.

2. Select a device (e.g. a video conferencing system) and double-click to add 
a function for the key. In this case, it should be a dialing function.

3. Double-click the added command and select Dial Value.

Display Screen

Dial Keys
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Advanced Functions
Use advanced options for button/slider actions that involve a series of actions 
(Macro), actions that the involve page redirect (Link), or actions that involve 
change or update of device settings of multiple objects (Set Variable).

Note: Associate Set Flag, Condition, Change Button State, or Change 
Label commands with device commands in the Commands list by 
dragging and dropping them into a tree view list, which allows them to 
initiate together (see Applications of Advanced Functions, page 137).

Macro – sends multiple commands to one or more devices. Select to add a 
macro command from the Function list. To create a macro, add multiple 
device actions to the Commands list, then click the Save as Macro  

icon or access the function by clicking the Library icon (page 152).
Link – makes the button into a link that directs you to a Viewer page. 
Select to add a page link from the Function list. Double-click the page link 
in the Commands list to select a different page link.
Set Variable – creates a variable to represent a device setting (e.g. speaker 
volume) that can be used by two or more control objects (e.g. slider bar or 
buttons) in the Viewer. This function is used when you have more than one 
Viewer objects controlling the same device.

Note: To complete this setting, go to Properties of the control objects and 
configure the Set Sync Conditions setting.

Set Flag – sets a flag value to represent the new device status when a 
command changes a device setting. Set Flags are added to the Commands 
list after device commands to change the Flag (device status).
Condition – adds one or more conditions that must be met for commands 
to initiate. The conditions can be based on a Variable or a feedback value 
(setting value sent from a managed device). 
Variable conditions– Use Variable conditions for the controller to carry 
out actions (commands) when the specified Variable meets the specified 
conditions. Use Variable If, Variable Else If, and/or Variable Else to 
fully cover all scenarios in your application. For example, if you want a 
display a warning message on the Viewer when the volume of a speaker is 
at its maximum (10 dB), you will need to: (a) Set up a Variable for the 
speaker volume; (b) Select a Variable If condition; (c) Double-click the 
condition to set the Variable value to 10; (d) Drag a Change Label 
command and nest it under the condition you selected in step (a); (e) 
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Double-click the Change Label command to type the warning message 
you wish to display when the speaker volume reaches 10 db.

Feedback conditions – Use feedback conditions for the controller to 
carry out actions (commands) when the specified feedback value meets 
the specified conditions. Use Feedback If, Feedback Else If, and/or 
Feedback Else to fully cover all scenarios in your application.

Note: The Else If and Else conditions can only be nested under the If 
conditions and can not be used on their own.

Change Button State – this command changes the image of another 
button when this button is pressed – allowing the image of any other 
button to change when the command from this button is sent. Change 
Button State is added to the end of the Commands lists. When adding this 
to a Toggle button it allows the image to switch with the toggle behavior: 
Normal or Pressed. In this situation the Change Button State is added to 
the end of both the Toggle ON and Toggle OFF Commands lists.
Change Label – this option changes a label’s text with text that you enter 
manually or with text from a device’s return message. A Manual Change 
Label can be added to the beginning or end and with a Condition in the 
Commands list. Adding it to a Condition guarantees the label only changes 
when the command initiates.
Change Group Button State – this option adds a command that changes 
the button selected in a Radio Group (page 79). Create a Radio Group 
and then a Function will be listed for it when Change Group Button State 
is selected. Add the Change Group Button State to the Commands list of a 
button and use the drop-down menu to select the button in the Radio 
Group you want selected. 
Change Slider Bar Level – this option adds a command that changes the 
level of a Slider Bar. Create a Slider Bar and then a Function will be listed 
for it when Change Slider Bar Level is selected. Add the Change Slider 
Bar Level to the Commands list of a button and use the drop-down menus 
to select the Slider Bar and Level to change.
Change Button Name – this option adds a command that displays 
specified text on another button when this button is tapped. A typical 
application of this command is when you want to show the assigned 
source on an output device as soon as the source is switched.

Function – lists the commands that can be added to the Commands 
list. Select an option under Device, then double-click or drag & drop 
commands from the Function list to add them to the Commands list. 
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Applications of Advanced Functions
Advanced Options allow you to include conditions with commands in the 
Commands list. Associate Set Flag, Condition, Change Button State or 
Change Label functions with a command in the Commands list by dragging 
and dropping them into a tree view listed with the command, so that they 
initiate in the order listed. 

Set Flag

Adds a Set Flag to change a Flag’s value when a command changes a device 
setting. This sets the Flag value to match the new device setting (e.g. ON or 
OFF). Always add a Set Flag to a Condition Flag, after the device action(s):

To add a Set Flag:

1. Under Device, select Set Flag.

2. From the Function list, select the Flag. 

3. From the Function list, drag and drop the Flag to add it to the end of the 
Condition Flag, in a tree view list:

4. Double-click Set Flag in the Commands list to use the drop-down menus 
to set the Flag and Value. 
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Condition

Adds a condition that must be met before the commands listed with it can 
initiate. When the button is pressed, the Condition's set value must equal the 
Flag or Feedback value for the command(s) to initiate. There are two 
condition types: Flag and Feedback.

Flag – Adds a condition based on a Flag’s value. “If Flag equals Value” is 
true, the condition is met and the commands listed with the Condition will 
initiate. Always add a Condition Flag at the top of the Commands list, 
drag and drop the device command(s) and then a Set Flag at the end, in a 
tree view list:

To add a Condition Flag: 

1. Under Device, click Condition.

2. From the Function list, select Flag.

3. Double-click Flag to add the Condition Flag to the Commands list.

4. Double-click the Condition Flag in the Commands list to use the drop-
down menus to set the Flag and Value. 
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5. From the Function list, drag & drop device commands to add them to 
the Condition Flag, in a tree view list:

6. Add a Set Flag after the last device command in the Commands list:

Feedback – adds a condition based on the text from a serial/telnet/TCP 
device’s return message. Always add a Condition Feedback to a serial/
telnet/TCP command, with command(s) added below the Condition 
Feedback, in a tree view list:

Receive Time – when a Feedback condition is added to a device command 
the wait to Receive Time drop-down menu appears allowing you to set the 
amount of time to wait before it stops receiving the return message from 
the device.

There are three Condition Feedback types:

Equal – when the text sent from a serial/telnet/TCP device’s return 
message matches all of the text entered for a Condition Feedback 
Equals, the commands listed below it will initiate.
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Include – when the text sent from a serial/telnet/TCP device’s return 
message matches part of the text entered for a Condition Feedback 
Include, the commands listed below it will initiate.
Bypass – this option bypasses matching text from the serial/telnet/TCP 
return message and initiates a Change Label command. The label’s 
text will change to the return message sent from the device (i.e. the 
Feedback Result). A Change Label must be added to the Feedback 
Bypass for it to work.

To add a Condition Feedback Equal/Include: 

1. Under Device, click Condition.

2. From the Function list, select Feedback.

3. From the Function list, drag and drop Feedback to add it to the Serial/
Telnet/TCP command, in a tree view list:

4. Double-click If Feedback equals to in the Commands list and use the 
drop-down menu to select equal to or include and enter the Text. 

Text entered here must match all (equal to) or part (include) of the text 
from a serial/telnet/TCP device’s return message for the command(s) to 
initiate. Use the ASCII / HEX drop-down menu to select the format. 
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5. From the Function list, drag & drop device command(s) to add them to 
the Feedback Equal/Include Condition, in a tree view list:

To add a Feedback Bypass Condition with Change Label:

1. Under Device, click Condition.

2. Select Feedback from the Function list.

3. From the Function list, drag and drop Feedback to add it to the Serial/
Telnet/TCP command, in a tree view list:

4. Double-click If Feedback equals to in the Commands list and use the 
drop-down menu to select bypass.

5. Under Device, select Change Label.

6. From the Function list, select the Viewer Page where the label is 
located.
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7. From the Function list, drag and drop the Viewer Page to add it to the 
Feedback Bypass Condition, in a tree view list:

8. Double-click Change Label in the Commands list and use the drop-
down menu to select a label. Labels are identified by number (see 
page 109).

The label’s text will change to the serial/telnet/TCP device’s return 
message. 
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Change Button State 

This option is used to change another buttons image when this button is pressed 
– allowing the button image to switch depending on the status: Normal or 
Pressed. Change Button State is added to the end of the Commands lists and 
should point to a Toggle button. Adding this to a Toggle button allows the 
image to switch with the toggle behavior: Normal or Pressed.

To add a Change Button State:

1. Under Properties, use the Mode drop-down menu to select a button type. 

2. Under Style, click the Normal and Pressed button to select an image/
color* for the button’s state. 

Note: Use the Style drop-down menu to select Image to import an image 
file for the button state, or Color to choose a color format for the 
button state.

3. Add the Toggle ON and Toggle OFF device commands to the Commands 
lists.

4. Under Device, select Change Button State.
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5. In the Function list, select the Viewer page.

6. Select the Toggle ON radio button, then in the Function list, double-click 
the Viewer page to add it to the end of the Toggle ON commands in the 
Commands list. 

7. Select the Toggle OFF radio button, then in the Function list, double-click 
the Viewer page to add it to the end of the Toggle OFF commands in the 
Commands list.

8. In each Commands list, double-click the Change Button State command 
to set the Button and State (Normal or Pressed). 
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Change Label

Changes a label’s text with text that you enter manually or with text from a 
serial/telnet/TCP device’s return message (Feedback Result). A Change Label 
that uses a return message, must be added to a Feedback Bypass Condition 
(page 141). A Manual Change Label can be added anywhere in the 
Commands list. Adding it to a Condition guarantees the label changes only 
when the command initiates. 

To add a Manual Change Label:

1. Under Device, click Change Label.

2. In the Function list, select the Viewer page where the label is located.

3. Double-click or drag and drop the Viewer page to add the Change Label 
to the Commands list.

4. Add a Change Label to multiple or Toggle ON / Toggle OFF Command 
lists to have the same label change text for different actions. 

5. In the Commands list, double-click Change Label to use the drop-down 
menu to select a Label and input the Text. This is the text in the label that 
will appear when the button is pushed. 

Repeat the steps to add a Change Label for the reverse action (i.g., On and 
Off). 
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Change Group Button State

Adds a command that changes the selection in a Radio Group (see page 79). 
To use this function, first create a Radio Group and then add a button to the 
Viewer page. Add a Change Group Button State independently or with a 
device command:

To add a Change Group Button State:

1. Under Device, select Change Group Button State.

2. From the Function list, select the Viewer Page where the Radio Group is 
located. 

3. From the Function list, drag and drop the Viewer Page to add it to the 
Commands list:

4. Double-click Change Group Button in the Commands list and use the 
drop-down menu to select the Button. 
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Change Slider Bar Level

Adds a command that changes the level of a Slider Bar. To use this function, 
first create a Slider Bar on a Viewer page. Add a Change Slider Bar Level 
independently or with a device command.

To add a Change Slider Bar Level:

1. Under Device, select Change Slider Bar Level.

2. From the Function list, select the Viewer Page where the Slider Bar is 
located. 

3. From the Function list, drag and drop the Viewer Page to add it to the 
Commands list:

4. Double-click Change Slider Bar in the Commands list and use the drop-
down menus to select the Slider Bar and Level. 
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Change Button Name

The Change Button Name command is used to display specified text on a 
selected button when the configured button is tapped. An application of this 
command is indicating the assigned source for a display device on a Viewer as 
soon as the source is assigned. This way, you can keep track of the source that 
is currently showing on a particular display device. 

Example: 
Indicate the currently assigned source on a display device (in the Viewer).
Assume an environment consisting of one monitor and five sources 
buttons (computer, laptop, camera...etc.), as illustrated below, and that 
when a source button is tapped, the source will be immediately assigned to 
the display. 

Configuration goal: To have the assigned source printing on the display 
button (on the Viewer page), configure each source button so that when it is 
tapped, the following actions (commands) initiate: (1) Display the source to the 
display; (2) Print the name of the assigned source onto the display device. 

1

2

4 5
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1. Click a source button to display the Button Action panel.

2. In the Button Action panel, select Change Button Name.

3. From the Function list, double-click the Viewer page where the source 
button is located. In this example, double-click the Video Wall option. 
The Change Button Name command is added.

4. From the Commands list, double-click the Change Button Name 
command and configure the following.

Select the ID of the display button to indicate the location of print the 
text. In this example, it is the video wall’s ID. 
Type the text you wish to show when the source button is tapped. In 
this example, enter “PC”.

5. Follow steps 1 to 4 to configure each of the source buttons.
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Graphic Library
The Library icon on the Project bar provides a Graphics tab and drop-
down menus with ready-to-use graphics for backgrounds, buttons, 

icons and device interfaces. Device Interface provides entire page layouts that 
you can use as templates for different types of devices. Double-click or drag 
and drop graphics to add them to the page. Images can be imported for icons 
and buttons in various formats (*.png,*.jpg,*.jpeg,*.bmp). 

Background Color

Button
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Icon

Device Interface
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Library

The Library icon on the Project bar offers the following functions. The table 
below provides an overview of each function.

Flag Flags are created to include parameters when settings are changed 
to indicate the current status. For details, see Flag, page 153.

Monitor Monitors allow you to set Conditions for Digital Input (dry contact) 
and Digital Input (VDC) signals and Flags on a port that will initiate 
an Action. In addition, you can create Listen to port and Query 
port monitors which check a device’s status to initiate actions. For 
details, see Monitor, page 155.

Macro Macros initiate a sequence of actions on one or more hardware 
devices. For details, see Macro, page 173.

Schedule Click to create scheduled events. For details, see Scheduled 
Events, page 175.

Variables Creates a Variable for a device setting (e.g. volume) that is 
controlled by two or more UI components (e.g. slider bar or buttons) 
on the Viewer. When the device setting is changed through one of 
the components, its setting is automatically synced and reflected on 
all components. For details, see Variables, page 176.

+ Opens a pop-up window to create a Flag, Monitor, Macro, 
Schedule, or variable.

x Closes the Library window. 
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Flag
Flags are created for control buttons to include parameters for when 
settings are changed or requests are made to change settings on a 

device. Flags indicate what the status is and what action to take according to 
the value. Flags are added as actions to Button Properties as a Condition or Set 
Flag value. 

Conditions tell a button to initiate associated actions if the flag value is true: “If 
Flag equals Value” initiate the action. Actions are associated with a condition 
so that they only initiate if the flag value is correct. That way an ON command 
is only sent to a device if the current flag value is OFF. 

Set Flag changes the flag value when a device setting has changed. So that if a 
device is OFF and the action turns the device ON, adding a “Set Flag 1 to ON” 
will change the flag value to ON. Now the flag’s value matches the device 
status so that actions associated with flag Conditions will initiate accordingly. 

Create flags for a device and add them as a Condition and Set Flag value in the 
Action – Button Properties (see Button / Slider Bar / Dial Kit Actions, 
page 127). 

To create a Flag:

1. Select Flag and click +. The New Flag menu appears.

2. Enter a Name and select a radio button to set the flag value.
Select On/Off and use the drop-down menu to select the Default Value. 
Enter a range (1-100) for the values in the two boxes and use the drop-
down menu to select the Default Value. Use the drop-down menu to 
select the format ASCII or HEX. 
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3. Click + to create more flags or double-click a flag to edit it. The flags will 
appear in the list, as shown below.

Name – Lists the Flag names which have been created. 
Value – Lists the flag’s values or range of values. 
Default – Lists the flag’s default value.

x – Deletes a flag from the list. 

4. Select Condition or Set Flag to add flags as a command in Button Action 
by selecting a button on a Viewer page (see Button / Slider Bar / Dial Kit 
Actions, page 127). 
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Monitor

Understanding Monitor
A Monitor allows you to set conditions on a port using Digital Input (VDC) 
and Digital Input (Dry Contact) signals, return messages, and Flags. When the 
condition is met, the controller will initiate the desired action. Digital Input 
(VDC) hardware devices provide voltage signals between 1 and 24. Digital 
Input (Dry Contact) hardware devices provide open and closed circuit signals. 
Hardware devices with return messages can be monitored using Listen to port 
or Query port conditions via text they transmit. These signals provide 
indicators from sensors or switches of an event. An event can be the 
temperature, power, dry contact, sensor, switch status, or message from a 
device. There are two parts to a monitor, the Condition and Action.

Monitor Page Options

Refer to the table below for an overview of the controls and options on the 
Monitor page.

Type Use this drop-down list to select a monitor type:

If – select this option for a single condition monitor. “If” the single 
condition is met, the action initiates. For details, see Creating an 
If Monitor, page 161.

Switch – select this option for multiple conditions that use more 
than one “If” conditions for the monitor. In this type, if one of the 
conditions is met, the monitor will initiate the action. For details, 
see Creating a Switch Monitor, page 164.

Bypass – select this option to transmit device feedback 
message to the selected variable actively listening for a 
message or by receiving a return message from the specified 
devices. For details, see Creating a Bypass Monitor, page 167.

While Loop – select this option to execute the specified actions 
at the defined frequency (Query Frequency). For details, see 
Creating a While Loop Monitor, page 168.

Professional – select this option to create variables and load 
values into these variables using programming script. For 
details, see Creating a Professional Monitor, page 169.

Name Enter a name for the monitor. 
Query Frequency Use this drop-down menu to select how frequently the monitor 

checks a device for a signal. 
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Condition Use this section to add one or more conditions that will need to be 
met for the Action to initiate. For details, see Condition Types, 
page 157.

Action Use this section to create the commands that will initiate when the 
monitor’s conditions are met. For details, see Device Functions, 
page 132 and Advanced Functions, page 135.
Click to hide or display the Device and Status/Function columns in 
the Condition and Action lists so that you can see a complete row of 
Conditions/Commands.
Click to move an selected command up or down in the Commands 
list.

Click to remove an selected command from the Commands list. 
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Condition Types
Listen to port / Query port

(Query port only) Click F(x) to open the drop-down menu to select a 
device command to send out; or enter a command string; and then the 
click Edit Return Message icon and do as explained below.

Edit Return Message
(Listen to port / Query port) Next configure the parameters for the 
return message from the device. This message must match for the 
condition to be met. In the Condition list double-click the command 

and then click  to open the Edit Return Message window:

Use the drop-down menu and enter a string of that will represent the 
characters in a return message from the serial device:

Select string with fixed length
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Use this to set a string of characters that are set within a fixed 
parameter. Enter a string of characters and use the S to set the start of 
the string and E to set the end and then click Apply. The return 
message will need to fit the fixed string of characters set in the text 
box next to the Drop-Down Menu (see next page) for the monitor to 
be triggered.

Select string with a non-fixed length 

Use this to set a string of characters where the parameters are 
variable. Enter a string of characters and use the S to set the start of 
the string and E to set the end and then click Apply. The return 
message will need to fit the fixed string of characters set in the text 
box next to the Drop-Down Menu (see below) for the monitor to be 
triggered.

Drop-Down Menu

Above, enter characters that the Select string with fixed length or 
Select string with non-fixed length string must match and how they 
must be matched: Equal to, Not equal to, Include, or Exclude for 
the condition to be triggered. 

Flag 
Creates a flag condition for the monitor. Use the drop-down menus to set a 
format (how the flag value must be matched) and the flag value for the 
condition to be triggered. 

I/O Input
Create a trigger signal from a device according to the voltage. Only device 
with a Digital Input (dry contract) or Digital Input (VDC) port appear in 
the Status list. Double-click a device in the Status list to add it to the 
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Condition list. Double-click the command in the Condition list to 
configure the setting:

The High or Low status tells the Monitor to initiate an Action when the 
device signal is above or below the threshold setting* for the port:

Digital Input (VDC)

High - states that when the voltage signal is above the Upper 
Threshold to initiate the Action.
Low - states that when the voltage signal is below the Lower 
Threshold to initiate the Action.

Digital Input (Dry Contact)

According to an open or closed circuit status for the port: 

Open - states that when the circuit is Open to initiate the Action.
Closed - states that when the circuit is Closed to initiate the 
Action. 
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Functions
Delay – adds a delay in seconds. Enter a number between 0.1-180. 
Relay – adds an Open, Close, Toggle or Pulse action on the selected 
controller and Relay port. 
DO – adds an Open, Close, Toggle or Pulse action on the selected 
controller and Digital Output port. 
Wake on LAN – powers on the specified computer (MAC address) 
over Ethernet.
Serial Raw (ASCII) – adds a serial command in the ASCII mode.
Serial Raw (HEX) – adds a serial command in the HEX mode. 
Telnet Raw (ASCII) – adds a telnet command in the ASCII mode.
TCP Raw (ASCII) – adds a TCP command in the ASCII mode. 
TCP Raw (HEX) – adds a TCP command in the HEX mode. 
UDP Raw (ASCII) – adds a UDP command in the ASCII mode.
UDP Raw (HEX) – adds a UDP command in the HEX mode.
HTTP – adds an HTTP command.
HTTPS – adds an HTTPS command.
TCP Feedback Raw (ASCII) – adds a feedback in ASCII format to 
having received a monitored input from a TCP client device.
TCP Feedback Raw (HEX) – adds a feedback in HEX format to 
having received a monitored input from a TCP client device.
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Creating an If Monitor

To create a monitor for a device port with a Condition that initiates an Action, 
click + from the Library’s Monitor tab, and do the following:

1. Select If from the drop-down menu and enter a name for the monitor. 

2. Use the drop-down menu to set the Query Frequency.

3. Select All Conditions or Any Conditions.

These options are only for advanced setups that require multiple events 
from hardware devices connected to multiple conditions. Most devices 
only require one signal Status added to the Condition List to initiate an 
Action. Most installations will not need to use this option, therefore it can 
be ignored. 

All Conditions: Add multiple conditions – all of which must be met 
for the Action to initiate. 
Any Conditions: Add multiple conditions – one of which must be met 
for the Action to initiate. 

4. Under Device, select a Controller from the drop-down menu, and then 
choose one of the following monitor types. For details, see Condition 
Types, page 157.
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Listen to port – to create a monitor that actively listens for a message 
from the device. Under Status, double-click a device port to add it to 
the Condition list.
Query port – to create a monitor that sends out a command to the 
device until a feedback message is received from the device. 
Flag – to create a flag condition for the monitor. 
I/O Input – to create a trigger signal from a device according to the 
voltage. 

5. Under Status, double-click to add a device port or flag to the Condition 
list. Then double-click the device port or flag in the Condition list to 
configure the condition settings.

Note: To set the controller as a TCP server, use the TCP Server option in 
the Status column, and make sure to type a TCP server port in the 
controller’s properties settings (page 89).

6. (Optional) Use the Operator option to add additional High or Low 
conditions (see step 4, page 161). 

7. Go to the Action section at the bottom of the page to select the hardware 
Device and add the Function to the Commands list, as explain in the 
steps that follow.

Note: For more information about Functions, see Button / Slider Bar / 
Dial Kit Actions, page 127.
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a) First select the hardware under Devices. 

b) Under Function, double-click a command to add it to the Commands 
list. This Command initiates when the Condition is met. For details on 
Functions and Commands, see Device Functions, page 132 and 
Advanced Functions, page 135.

Note: If you have configured the controller as a TCP server, add TCP 
Feedback Raw (ASCII) or TCP Feedback Raw (HEX) command 
to provide feedback to the TCP client.
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Creating a Switch Monitor

1. Select Switch from the drop-down menu and enter a name for the monitor. 

2. Use the drop-down menu to set the Query Frequency.

3. Use the options to create multiple condition comparisons, as explained 
below.

Type Use the drop-down menu to select:
If – select this option for a single condition comparison monitor. 
Switch – select this option for multi-condition comparisons that use 
multiple “If” comparisons for the command. 

Name Enter a unique name for the monitor. 
Query Frequency Use this drop-down menu to select how frequently the monitor 

checks a device for a signal. Options are: 100 ms - 1 second. 
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4. Go to the Action section at the bottom of the page to select the hardware 
Device and add the Function to the Commands list, as explain in the 
steps that follow.

Note: For more information about Functions, see Button / Slider Bar / 
Dial Kit Actions, page 127.

Drop-Down Menus Under the Type drop-down menu are four addition drop-down 
menus used to configure the Switch Condition: 

Controller – use the first drop-down to menu select the control-
ler for a Switch condition. 
Listen to port / Query port – use the second drop-down menu 
to select the condition type for a Switch condition (see step 4, 
page 162 for details).
Serial Device Port 

Use the third drop-down menu to select a serial device port 
and configure Edit Return Message (to configure, see Edit 
Return Message, page 157).

To set the controller as a TCP server, use the TCP Server 
option in the Status column, and make sure to type a TCP 
server port in the controller’s properties settings (page 89).

Case – use the fourth drop-down menu to add cases by selecting 
Add More Cases for comparison that need to be met before 
monitor’s condition will initiate. In the left text box enter a name 
for the Case, in the right text box enter the character string that 
the return message should match. 

Action Use this section to create commands for the monitor. See Button / 
Slider Bar / Dial Kit Actions, page 127, for details on configuring 
commands.
Click this icon to switch to the Action list view so that you can see a 
complete row of the command’s functions. This is a toggle button. 

x Closes the Monitor window. 
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5. First select the hardware under Devices. 

6. Under Function, double-click a command to add it to the Commands list. 
This is the Command that initiates when the Condition is met. For details 
on what each function does, see Device Functions, page 132 and Advanced 
Functions, page 135.

Note: If you have configured the controller as a TCP server, add TCP 
Feedback Raw (ASCII) or TCP Feedback Raw (HEX) command 
to provide feedback to the TCP client.

7. You can also add a Macro, Link, Set Flag or Monitor’s Condition.

8. After adding all the functions to the Commands list, the Switch monitor is 
complete. 
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Creating a Bypass Monitor

Follow the steps below to create a bypass monitor.

1. Select Bypass from the drop-down menu and enter a name for the monitor. 

2. Configure the following settings. 
Query frequency: sets how frequently the monitor checks the device 
for a signal. Valid values range from 100 ms to 1 second.
In the second drop-down list, select one of the following:

Listen to port: actively listens for a message from the specified 
device. 
Query port: when a setting is changed on the specified device, 
the device sends a feedback message to the controller, informing 
the latest setting.

In the last drop-down list, select the port or the device to be monitored.

3. Configure the actions.

a) Select Set Variable.

b) Double-click the variable you wish to update when controller detects a 
change for the specified device setting.

c) For a variable, double-click the command and select Bypass.
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Creating a While Loop Monitor

Follow the steps below to create a while loop monitor.

1. Select While Loop from the drop-down menu and enter a name for the 
monitor.

2. Use the Query Frequency drop-down menu to define the frequency at 
which the device checks for signals.

3. From the Device list, select a device. 

4. (Optional) Select an advanced option. For details, see Advanced 
Functions, page 135.

5. Double-click a function to added it to the Commands list. For details, see 
Device Functions, page 132 and Advanced Functions, page 135.

6. Configure the added commands if required.



Chapter 4. ATEN Configurator (VK6000)

169

Creating a Professional Monitor

Example: Keep track of the assigned sources by indicating the input port 
number of the assigned source on each of the four screens on a Viewer page, 
as illustrated below.

For the controller to print the port number of the assigned source on each screen 
and keep this information up-to-date, the controller needs to:

constantly keep track of the assigned source
constantly print the port number on each screen icon
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Follow the steps below to create a professional monitor.

1. In Configurator, click Library  and click Monitor .

2. Click  to create a new monitor.

3. Configure the following settings.
From the Type drop-down menu, select Professional.
Name the monitor.
Define the query frequency.

4. Configure the condition settings.
In this example, the controller VK2100 is set to query the input and output 
ports of the Matrix Switch, VM6404H, that connects to the controller 
every 0.1 second.

Add the condition(s) that must be met for initiating actions. For details 
on conditions, see Condition Types, page 157. 
Select a Trigger Mode for the added conditions.

And: Only initiate the added actions (commands) if the values of 
all specified inputs change.
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Or: Initiate the added actions (commands) if the value of any 
specified input changes.
Independent: Use this option when you have multiple sets of 
actions. The added actions (commands) initiate if the 
corresponding set of inputs change in value.
Always: Initiate the added actions (commands) at the specified 
frequency.

5. Configure the Action settings.

a) Click Edit to script the codes. 

Note:
This editor follows Lua’s programming rules. ATEN suggests using 
Notepad++ to script the codes before adding them to the Editor.
For details on built-in commands, see Built-in Commands, page 172.
When scripting codes for I/O inputs, use lower case “l” to represent the 
close status (e.g. input_io == ‘l’), and “h” to represent open status 
(e.g. input_io == ‘h’).

In this example, use Script Editor to:

Convert data format.
Create four variables representing the assigned input for each screen. 
In this example, InputNToOutput1, InputNToOutput2, 
InputNToOutput3, and InputNToOutput4 are created.
Load the input number of the assigned source to the created variables.

Below is sample of the scripts used for this scenario:

function vk_parser(input)
dglocal vminput = vk_hex_toascii(input)
dg-- local vminput = input
dgif vminput == nil or vminput == ’’’’ then
dgsdfsdfdf s return
fgend

d local map = {}
fgfor vmout, vmin in string.gmatch(vminput, “o([0-9]*)i([0-9]*) video [^ ]* audio [^ ] * [^\n]*”) do
fgsfdsfdfsfdsmap[vmout] = vmin
fgend

dglocal vk_var_1_InputNToOutput1 = map[”01”]
f glocal vk_var_2_InputNToOutput2 = map[”02”]
dglocal vk_var_3_InputNToOutput3 = map[”03”]
dglocal vk_var_4_InputNToOutput4 = map[”04”]

dgvk_docommands_1_VMRead(vk_var_1_InputNToOutput1, vk_var_2_InputNToOutput2, vk_var_3_InputNToOutput3, vk_var_4_InputNToOutput4)
end
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b) Add actions. 
In this example, add four Change Button Name commands:

For details, see Device Functions, page 132 and Advanced Functions, 
page 135.

Built-in Commands

Command Description

jsonobj Converts JSON strings to tables.

vk_ascii_to_hex Converts strings from ASCII to Hex.

vk_docommands_ID_name Defines the commands to be executed, e.g., 
vk_docommands_1_output. A 

the user should define his/her own commands and their 
corresponding IDs. As long as the ID does not change, 
the command name can change.

The same ID cannot be used for two different 
commands. The same applies to command names.

vk_hex_to_ascii Converts strings from Hex to ASCII.

vk_parser(input1, input2) Use this command to indicate a start to a set of 
scripts. 

The brackets should contain equal number of inputs 
that you added in the Professional Monitor setup. 

If the Trigger Mode is set to independent, the script 
should contain only one input, but the number of 
parsers should match the number of inputs added 
to the Monitor, e.g. vk_parser_1(input), 
vk_parser_2(input).

vk_var_ID_name Create a variable.



Chapter 4. ATEN Configurator (VK6000)

173

Macro
Macros allow you to create a button that will initiate a sequence of 
actions across the same or different hardware devices. This saves time 

by allowing multiple devices to initiate actions all at once from one button. For 
example, you can create a macro to start a video presentation by adding 
functions to: dim lights, power on source, power on display, lower screen and 
play source. You can also add time delays between actions in a macro. Each 
project can store up to 128 macros.

When you click + from the Library’s Macro tab, the window opens: 
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To create a macro:

1. Select Macro and click +. 

2. Enter a Name and select a Viewer from the drop-down menu, then click 
OK. 

3. Go to the Actions section at the bottom of the page to select hardware 
under Device and add the Function to the Commands list:

Note: For more information about adding Functions, see Button / Slider 
Bar / Dial Kit Actions, page 127.

4. After adding all the functions to the Commands list, the macro is complete.

5. In Create Viewer & Design, create a button and add a macro to the Button 
Action properties (see page 127) by selecting Macro under Devices (see 
Device Functions, page 132 for details).
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Scheduled Events
You can automate ATEN Control System to perform one or a series of tasks on 
recurring schedule. Each project can store up to 60 scheduled events.

To create a new event, follow the steps below.

1. Click  and then click . 

2. Name the event.

3. Click to specify a recurring schedule for the event.

4. Configure event actions.

a) In the Device column, select a device.

b) In the Function column, double-click the desired functions. The 
corresponding commands appear in the Commands column. For details 
on what each function does, see Device Functions, page 132.

c) In the Commands column, double-click each command to configure the 
settings.

5. Optionally add system functions. For detailed information, see 
Applications of Advanced Functions, page 137.

6. These commands will initiate in the listed order. To change the order of the 
commands, click .
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Variables

Understanding Variables

A Variable is a value holder that stores a single device setting (e.g. speaker 
volume) and can be assigned to multiple UI components (e.g. a slider button, a 
maximum volume button, and a minimum volume button). This way, when a 
device setting is adjusted via a Viewer object, the new setting will be loaded 
into this Variable and then reflected to all Viewer objects that use this Variable. 
Each project can store up to 128 Variables.

This feature is useful for automatic synchronization of device settings, 
especially when you have two or more objects in a Viewer controlling a single 
device setting. Take the example of controlling a speaker volume on a Viewer. 
On your Viewer, you may have a slider bar which you use to adjust the volume, 
a button that sets the speaker to its maximum volume, and another button for 
minimum volume. When you tap the maximum volume button, you would like 
the following status changes reflected on the Viewer:

The maximum volume button shows a toggle-on status
The minimum volume button synchronized with this setting and shows a 
toggle-off status
The slider bar synchronizes with this setting and moves to its highest 
volume
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Creating a Variable for Devices that Return Feedback Messages
Follow the steps below to configure a Variable if the Variable (device setting) 
is for a device that returns feedback messages to the controller.

1. Create a Variable for the device setting (e.g. speaker volume).

a) In the Design tab, click Library.

b) Click the Variable  icon and then click . 

c) Configure the following settings.
Name: Type a name for the Variable.
String format: Select the string format for the target device.
Setting range: Type two numbers to define the range for the variable. 
Valid numbers include negative numbers and numbers that contain one 
decimal place.

Note: If one of the numbers contains a decimal place (e.g. -5.0), make 
sure to specify the other number in the same format (e.g. 10.0). 

Default value: Type a default for the setting.
Your settings may look like this:

2. Configure control components for the Viewer. For details, see Design, 
page 100.

a) In the Design tab, add control components to your Viewer. 

Note: The Variable function is only applicable to toggle buttons, basic-
mode slider bars, and radio groups of normal buttons. Configure the 
Mode setting before you proceed.
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b) For a slider bar component, click it in the Viewer page and configure 
the Value settings in Properties.

c) In Properties, click Set Sync Condition and select the variable you 
created using the drop-down list.

3. Create a Monitor to set up the conditions for which the device sends its 
latest setting to the variable. For detailed steps, see Creating a Bypass 
Monitor, page 167.
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Creating a Variable for Devices that Do Not Return Feedback 
Messages
Follow the steps below to configure a Variable if the Variable (device setting) 
is for a device that does not return feedback messages to the controller.

1. Create a Variable for the device setting (e.g. speaker volume).

a) In the Design tab, click Library.

b) Click the Variable  icon and then click . 

c) Configure the following settings.
Name: Type a name for the Variable.
String format: Select the string format for the target device.
Setting range: Type two numbers to define the range for the variable. 
Valid numbers include negative numbers and numbers that contain one 
decimal place.

Note: If one of the numbers contains a decimal place (e.g. -5.0), make 
sure to specify the other number in the same format (e.g. 10.0). 

Default value: Type a default for the setting.
Select a command execution type.
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Execute commands with no conditions: Execute the command 
(action) when the specified Variable changes.
Execute commands with the specified conditions: Execute the 
corresponding command (action) when the Variable matches. 

2. Configure control components for the Viewer. 

a) Add a control component to the Viewer. For details, see Design, 
page 100.
Note: Make sure to configure the component mode before proceeding 
to the next step.

b) For a slider bar component, click it and configure value settings in 
Properties.

c) Click Set Variable, and then double-click the Variable you created in 
step 1.

d) In Properties, click Set Sync Condition and select the Variable you 
created using the drop-down list.

3. Repeat steps (a) to (d) with each of the components.If you select Execute 
commands with the specified conditions, follow the steps below to add 
commands.

a) Refer to step 4 to first configure the UI components.

b) Click Library, click the Variable  icon, and then click the Variable 
you created in step 1.

c) Click the drop-down list below the Execute commands with the 
specified conditions option and select a condition.
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d) Add an action (command) when this condition is met. Select a device, 
double-click a desired function, and then double-click the command to 
configure the setting. 
In the case of speaker volume, when the volume changes to 0 (i.e. the 
condition is Variable = 0), the action will be “to change the speaker 
volume to 0”, as illustrated below.

e) Repeat steps 2(c) and 2(d) to add one or more actions to each condition.

4. If you select Execute commands with no conditions, follow the steps 
below to add commands.

a) In the Device list, click to select the device. In this example, the mixer, 
840T-1(Serial), is selected.

b) Double-click the action (command) and change the value type to 
Variable Value.
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Upload

The Upload page allows you to upload Viewers and/or back up projects to 
controllers.

To back up a project and its Viewers to a controller:

1. Browse for the ATEN controller where you wish to save the configured 
Viewers.

Auto Search: Browses for controllers on the same LAN with the 
Configurator.
Search by IP address: Use this function to browse for controllers that 
are on different LANs to the Configurator.

2. Select one or more Viewers you wish to upload.
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3. Optionally click on the following to configure password authentication 
settings.

Note: Due to security concerns, the access key of any ATEN controller 
will need to be modified at least once before the controller can be 
accessed for any of its functions. If you have not modified the access 
key, the upload will not be performed. To resolve this issue, log in 
to the controller’s web interface and follow the on-screen prompt to 
modify the access key.

Edit Access Key: Click to edit the access key you entered for 
uploading Viewers to the controller and download Viewers from a 
mobile device.

: An access key is required to upload Viewers to the controller 
and download Viewers from a mobile device.

: An access key is not required to upload Viewers to the 
controller and download Viewers from a mobile device.

 : The access key has been changed on the controller’s web 
interface (Dashboard). To change the lock status, click on the icon and 
type the new access key to proceed.

4. Click Upload to Controller.

Note: By default, the project file is uploaded along with your selected 
Viewers. To only upload the selected Viewers, click Also upload 
project file to disable the function.



ATEN Control System User Manual

184

Viewing Controller Information
Click  to view the controller’s information.

IP Address: Displays the IP address. 
MAC Address: Displays the MAC address.
License: Displays the number of licenses available and in use. 

Select License: Allows you to load a new license file.
Reset License: Resets all license(s) in use by mobile devices. This will 
disconnect all mobile device connections to the controller.

Firmware Version: Displays the firmware version.
Select Firmware: Allows you to load a firmware upgrade file to update 
the firmware. 

Capacity: Displays the amount of space available for uploading Viewers.
Viewers: Lists the Viewers currently stored on the controller.

Remove Viewer: Click the trash can icon to remove the Viewer stored 
on the controller. 

Project: Lists the project file currently stored in the controller.
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Chapter 5
ATEN Database Generator

Overview

The ATEN Database Generator lets you add, edit, and manage hardware 
devices for My Device Library. To open the Database Generator from the 
ATEN Configurator, use the menu bar to select Tools → Database Generator. 
The first time the application is opened, a window appears with four options:

Add New Device Configure a custom hardware device to add to My Library. 
Add Device from 
ATEN Device Library

Add devices from the ATEN Device Library to My Library. 

Add Device from 
Driver File

Add devices from a database file (*.vkd) to My Library. 

Check Box Click Do not show this dialog again to prevent the dialog from 
appearing when the Database Generator is opened. Use the 
Preferences menu option to bring the dialog window back. 

Close Click the Close button to exit the dialog window. 
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My Library

My Library allows you to create custom hardware devices which can be 
selected to configure ports on the controller. My Library lists all the hardware 
devices that you have created, added, and edited using the Database Generator. 
You can create new hardware devices or add existing devices from the ATEN 
Device Library (page 204). These devices can then be selected from My 
Device Library for use. 
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Menu Description

File The File menu provides options to:

Add New Device: Configure a custom hardware device to add to 
Device Library.

Add Device from ATEN Device Library: Add devices from the ATEN 
Device Library to My Library.

Add Device from Driver File: Add devices from a database file 
(*.vkd) to My Library.

Export My Library: Saves My Library as a database file (*.vkd) that 
can be imported later.

Export Selected Device: Saves the selected device(s) as a database 
file (*.vkd) that can be imported later. 

Controller Connection: Searches for a controller to test the connec-

tion or run the learning mode for the IR port.

Quit: Exits the program. 

Edit The Edit menu provides options to:

Delete: Deletes the selected devices from the database. 

Duplicate: Makes a copy of the selected device(s) and adds them to 
the library with the extension “-Copy”

Preferences: Provides options to:

Set the Language 

Show Add Device dialog on startup 

Show IR Learning tips

Set the IR Learning Timeout - how long to attempt a connection to 
an IR device before IR learning stops.

Library Provides a list of the Libraries that you can open to select devices from 
and edit or add to My Library. The libraries that are listed here appear 
when you select a database using Add Device from Driver File.

Help Provides support and software version information. 
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Managing My Library 

Overview
When devices are added to My Library, they appear listed in the main window. 
New devices can be added by creating a new device, copying an existing device 
or by selecting a device from the ATEN Library. Use the check boxes to select 
individual devices or All to select the entire list.

Click to add a new custom device to the database.

Select a device and click this icon to create a duplicate.

Click to add and edit a device from the ATEN Device Library.

Click to add a device from the driver file.

 Select a device and click Edit to change the settings.
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 Key in word strings then click Search to find a device.

Click All, Serial, IR, DO, Relay or Ethernet to filter the list by type. 
Click Brand, Category, Model, Type or Version to sort the devices.
Click Export Selected Device to save the selected devices. 
Click Delete Selected Devices to remove the selected devices. 

Edit / Add New Device
To edit or add a device to My Library, do the following:

1. From the menu select File → Add New Device, or select a device from My 
Library and click Edit.

2. Under General, use the drop-down menus or type in the Brand Name, 
Category, Model and Version. 
Note: The Category determines what buttons are auto generated when a 
Viewer page is created for the device. 

3. Use the History button to open the Version History editor and make notes 
about the updates being made to the device configuration. You can create 
and use different versions of the same device and track the changes. The 
version history can be viewed and different versions selected from the 
ATEN Configurator, under device Properties. 

4. Check the hardware type and configure the device:
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Serial

 Click to add an Action. 

 Click to create a duplicate of the Action.

 Click to delete the selected action. 

 Click to enter a string within () which allows the text to be edited 
from the VK6000 in the Button Action - Commands list (see page 129).

 Click to add a drop menu into a Command string, then enter the 
number sequence in the brackets []. The Function name must include 
an Astrix (*) for each drop menu in the Command string.The drop-
down menu will appear where the (*) is entered in the Function name. 

 Click to add an Enter into the Command string.
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Right-click one or more serial commands to copy and paste them as 
Ethernet commands of all protocols (except HTTP/HTTPS):

Settings – Use the drop-down menus to set the: Baud Rate, Data Bit, Stop 
Bit, Parity, Flow Control and Mode settings. 

Advanced
Delay Interval – Sets a time delay for each command before they 
are sent to the device. 
Feedback Timeout – Sets the maximum interval that the 
controller allows in between parts of a feedback message. If the 
controller has not received any feedback for longer than the 
specified Feedback Timeout, the controller identifies the last bit 
of the received information as the end of a feedback message.
Receive Duration – Sets the allowed duration of time for the 
serial device to receive a complete message from the controller.
Keep Connection Alive – Specify an interval that the controller 
waits before sending the specified command to test if the 
connection to the serial device is up or down.

Function List – Use this section to configure the device functions by 
adding actions to the list. 

String Format – Use the buttons to select HEX or ASCII. To use HEX 
strings with ASCII one, select ASCII and type \x before typing the 
HEX strings. 

Note: HEX strings are also supported under the ASCII format.

Function – Lists the actions created for a device. A Function name 
must include an Astrix (*) if you are adding a drop menu to the 
Command string. Double-click to edit the function name. 
Command – Shows the command string created for the action. 
Double-click to edit the string.
Feedback – Stores return messages generated by testing the command 
strings. Double-click to manually add or remove stored messages.
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Click Send to connect to a controller and test the typed command. 

Click to select a controller from the list. Use the Refresh button to 
refresh the list. To browse for controllers in the LAN, click the 
Intelligent Search button or type the IP address of the controller.
Click OK to proceed to test the command. For details, see Testing 
Commands, page 202.



Chapter 5. ATEN Database Generator

193

Text Command Tools

The following formats allow you to enter command strings with text that 
provide special features. These formats work in Serial and Ethernet commands. 

()  entering text in () allows the command to be edited in the VK6000. 
Example: (A1 A9) (A8 B6) – this command string will provide two 
editable text boxes from the VK6000 in the Button Action - Commands list 
which allow you to change the command string:

=  using the equals sign before a text command allows you to type in 
words which will show up in a drop-down menu to describe the command, 
rather than show the text command itself. 
Example: [Power On=0A,Power Off=0B,Standby Mode=0C] – this 
command string will provide a drop-down menu with three choices using 
the text before the equal signs to describe each command – from the 
VK6000 in the Button Action - Commands list:

““  quotation marks allow three symbols (, = @) to be added to a 
command that uses the equal sign as described in the example above. 
Three symbols not allowed within the quotation marks include (“” () []). 
Quotation marks can be used to the left of = in a HEX command; on either 
side of = in an ASCII command; and anywhere in an Ethernet command.

HEX Example: [“Power=On”=0A,”POWER=Off”=0B]

ASCII Example: [“Power=On”=pwn,”POWER=Off”=pwf]

In the HEX example, “Power=On” allows the equal sign to be inserted 
before =0A. If the quotes are removed, the command Power=On=0A 
would fail as an Invalid String.
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IR

 Click to add an Action. 

 Click to create a duplicate of the Action

 Click to delete the selected action. 

Settings – Use the drop-down menu to set the Repeat setting (number of 
times a signal is sent): 1 Time, 2 Times or 3 Times (Default). 

Advanced 
Delay Interval – Sets a time delay for each command before they 
are sent to the IR device. 
Receive Duration – Sets the allowed duration of time for the IR 
device to receive a complete message from the controller.

Function List – Use this section to configure the IR functions by adding 
actions to the list. 

Quick Mode – Click to run Learning Mode for all IR actions in the 
Function List. When the Quick Mode window opens, click Start, a 
pop-up window appears to select a controller. Check a box to select a 
controller and click Select. Click Start a second time to run Quick 
Mode using the Learn instructions below. 
Function – Lists the actions created for a device. Double-click to edit 
the Function the name. 
Status – Reports the status (Tested, Failed, Learned) of the Learn and 
Test buttons. 
Learn – Use to transfer commands from an IR remote to the Control 
Box. Click Learn. The Select Controller window appears. 
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Click to select a controller from the list. Use the Refresh button to 
refresh the list. To browse for controllers in the LAN, click the 
Intelligent Search button or type the IP address of the controller.

Click Learn a second time to start learning mode. When the IR 
Learn LED flashes green, point the IR remote at the Control 
Box’s front panel IR Receiver and push a button on the remote. 
Press the button on the remote just as you would when using it 
with the hardware device. If the device responds to a long hold or 
quick tap of the remote’s button then you must press the button in 
the same manor (long hold or quick tap) when it using for 
Learning mode. The Control Box will beep and the Learn LED 
will light solid (then turn off) when IR learning is successful. The 
LED also turns off if Learning mode times out.

Test – Use to test if commands are sent successfully to the Control Box 
and hardware device. 

Click Test, a pop-up window appears to select a controller and the 
IR port. Check a box to choose a controller and use the drop-down 
menu to select the IR port and then click Select. 



ATEN Control System User Manual

196

Click Test a second time to test if the IR data transmits 
successfully to the Control Box. Check the hardware device to 
confirm that it responded appropriately. 

The Status column reports the Learn and Test results.

Digital Output

 Click to add an Action. 

 Click to create a duplicate of the Action

 Click to delete the selected Action. 

Advanced – Click to use the Delay Interval drop-down menu to set a 
timed delay for each command before it is sent to the device.
Function List – Use this section to configure the Digital Output device 
functions by adding actions to the list.

Function – Lists the actions created for a device. Double-click to edit 
the Function name. 
Command – Shows the command selected for the action. Click the 
drop-down menu to select an action (Open, Close, Toggle, Pulse).
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Relay

 Click to add an Action. 

 Click to create a duplicate of the Action

 Click to delete the selected Action. 

Advanced – Click to use the Delay Interval drop-down menu to set a 
timed delay for each command before it is sent to the device.
Function List – Use this section to configure the Relay device functions 
by adding actions to the list.

Function – Lists the actions created for a device. Double-click to edit 
the Function name. 
Command – Shows the command selected for the action. Click the 
drop-down menu to select an action (Open, Close, Toggle, Pulse).
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Ethernet

 Click to add an Action.

 Click to create a duplicate of the Action.

 Click to delete the selected action.

 Click to enter a string within () which allows the text to be edited 
from the VK6000 in the Button Action - Commands list (see page 129).

 Click to add a drop menu into a Command string, then enter the 
number sequence in the brackets []. The Function name must include 
an Astrix (*) for each drop menu in the Command string. 

 Click to add an Enter into the Command string.

Right-click one or more Ethernet commands (except HTTP/HTTPS) to 
copy and paste them as serial commands:

For special command string tools, see Text Command Tools, page 193.
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Settings
Protocol – Click the drop-down list to select a protocol for the device
Port – Type the port number for the device.
Advanced – Click to access the following settings. The supported 
settings may vary depending on the device protocol and authentication 
type.

Delay Interval Sets a time delay for each command before they are 
sent to the device.

Delay Time after 
Login

Sets a time interval that the controller waits to request 
for login credentials of a device after establishing 
connection with the device.

Receive Duration Sets the allowed duration of time for the Ethernet 
device to receive a complete message from the 
controller.

Send command 
after successful 
connection

Enter a First and Second Command to send to the 
device after a successful connection has been 
established. 

Auth Type Sets the authentication type for the device.
Timeout Specifies the maximum time that the device allows for 

receiving each feedback message from the device 
before timing out.

Login Sets the command for logging in to the device.
Parameter Sets the parameters (keys) of the device that are 

required for the controller to connect to the device. 
For example, the device username and password are 
required when connecting to the device, and the valid 
values are admin and 123456 respectively. 

Keep Connection 
Alive

Specify an interval during which the controller sends 
the specified command to make sure the it is 
connected to the Ethernet device.

Automatically 
reconnect if no 
return message is 
received 

Check this box if you want to continue reconnection 
attempts when no return message is received from the 
device.

Use Default Click this button to restore to default settings. 
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Function List – Use this section to configure the device functions by 
adding actions to the list. 

String Format – Use the buttons to select HEX or ASCII. (TCP only)
Function – Lists the actions created for a device. A Function name 
must include an Astrix (*) for each drop menu you add to the 
Command string. Double-click to edit the function name. The drop-
down menu will appear where the (*) is entered in the Function name
Command – Shows the command string created for the action.

To edit a command for a Telnet, PJLINK, ONVIF, or TCP 
compliant device, double-click the Command field (green area in 
the interface).
To edit a command for an HTTP or HTTPS compliant device, 
click the Edit button. The Edit HTTP Command window appears.

Feedback – Stores return messages generated by testing the command 
strings. Double-click to manually add or remove stored messages. This 
function is not applicable for ONVIF devices.
Send – Click this button to test the command for the function. The 
return messages can be saved to Feedback. 
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This screen appears when Send is clicked. Select a controller for the 
device to connect and configure the fields such as device IP address. 

Note: The username and password are not required for UDP and TCP 
devices, and the username is not required for PJLINK devices.

Intelligent Search Click to locate controller without specifying an IP 
address.This option only searches for controllers on the 
same local area network. For controllers across a 
network device, such as a router or switch, you must 
specify the IP address. 

Search by IP address Enter the IP address and click Search to locate a 
controller.

Controller ID Use the check box to select the Controller, fill in the IP 
Address, Username and/or Password and then click 
OK. Next use the instructions below this table. 

Refresh Click this button to refresh the Controller ID list.
IP Address Type the IP address of the device.
Username Type the device’s username.
Password Type the device’s password to grant access right to the 

controller.
Receive message for Specifies the maximum allowed time that the device 

receives messages from the selected controller.
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Testing Commands

After selecting a controller for the device and configure the required settings 
(if any) in the select controller window, click OK to proceed to test the typed 
command. The Test Command window appears. 

Select which device to send command to by choosing Send to all or Send to 
specific and then click Send Test Command. This window appears.
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The test results will appear in the yellow area of the window and the feedback 
messages listed in the Feedback column.

Add – Click to save a feedback message in the Saved Feedback message 
window.
Pause / Continue – Click to pause sending/receiving the command/return 
message. 
Save & Exit – Save the feedback messages to the list and close the 
window.
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ATEN Library
The ATEN Library is accessed on the Library menu bar selection and provides 
the complete list of hardware devices available in the database. The You can 
add any device in the ATEN Library to My Library. Once a device is added to 
My Library, the device settings can be edited as needed. 

Use the check boxes to select devices to add to My Library. Check All to 
select all devices in the list. 
Key in word strings then click Search to find a device.
Click All, Serial, DO, IR, Relay or Ethernet to filter the device list by 
type. 
Click Brand, Category, Model, Type or Version to sort the devices.
Click Add to My Library to add the selected devices to My Library. 
Click Cancel to return to My Library.
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Chapter 6
Remote PC Control

Overview

While being capable of controlling serial, IR, I/O, and relay equipment, ATEN 
controllers also support remote control of computers This control is achieved 
with a program, ControlAssist, that grants control right to a specified ATEN 
controller via the network. When a computer is installed with ControlAssist, 
you can remotely perform the following:

Control PowerPoint slides
Control media files through Windows Media Player
Initiate actions on third-party programs using hotkeys that have been 
defined for the programs
Perform system control such as shutting down the computer, execute 
command prompt, set system volume, and run a program

Note: For a full list of supported actions, see Supported PC Control Actions, 
page 215. 

Specifications

Supported computers
Only Windows-based computers are supported for remote control.
Each computer is deemed as an Ethernet device to the ATEN 
controller, and therefore follows the specification that each controller 
can support up to 25 Ethernet devices.

To use ATEN Viewers on a Windows platform, make sure to install 
Internet Explorer version 11 or later.
PowerPoint File Control

ControlAssist only supports PowerPoint files that contain 200 slides or 
less, and are created using Microsoft Office 2007/2010/2013, or WPS 
Office.
ControlAssist only supports the following PowerPoint file formats: 
pps, ppt, and pptx.
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Media File Control
ControlAssist only supports media files created using Windows Media 
Player.
When a media file is remotely enabled and controlled using an ATEN 
Viewer, the file opens in Windows Media Player and this setting can 
not be changed.
If you encounter any issues playing a media file, try install a third-
party video codec.
ControlAssist only supports control of the following media file 
formats: 

Category File Formats

Windows Media format asf, wma, wmv, wm

Windows Media Metafiles asx, was, wvx, wmx, wpl

Microsoft Digital Video Recording dvr-ms

Windows Media Download Package wmd

Audio Visual Interleave avi

Moving Pictures Experts Group mpg, mpeg, m1v, mp2, mpa, mpe, m3u

Musical Instrument Digital Interface mid, midi, rmi

Audio Interchange File Format aif, aifc, aiff

Sun Microsystems and NeXT au, snd

Audio for Windows wav

CD Audio Track cda

Indeo Video Technology ivf

Windows Media Player Skins wmz, wms

QuickTime movie file mov

MP4 audio file m4a

MP4 video file mp4, m4v, mp4v, 3g2, 3pg2, 3gp, 3gpp

Windows audio file aac, adt, adts
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Setting Up Remote PC Control

Follow the steps below to install the required programs on the target 
computers, configure the associated controller, and customize the Viewer for 
remote PC control.

1. Make sure you have installed Microsoft Visual C++ Redistributable for 
Visual Studio 2015 to the target computer. To download the package, go to 
https://www.microsoft.com/en-us/download/details.aspx?id=48145

2. Install ControlAssist on the computer you wish to control. For detailed 
steps, see Installing ControlAssist on Target Computers, page 207.

3. Add the computer into the control system. For detailed steps, see Adding 
Target Computers to the Control System, page 210.

4. Create a control interface to be used on a licensed mobile device. 
For detailed steps, see Configuring a Control Interface, page 212.
For details on licenses, see Licenses for Mobile Control, page 59.

Installing ControlAssist on Target Computers
Follow the steps below to install ControlAssist on the computers you wish to 
control. 

1. Download ControlAssist.

a) Visit the ATEN download page:
https://www.aten.com/global/en/products/professional-audiovideo/
control-system/controlassist/

b) Search for “VK6000”. A list of downloads for VK6000 appears.

c) Click ControlAssist_Vx.x.xxx.zip to download.

2. From the downloaded file, double-click ControlAssist_Setup to install 
the program. An installation wizard appears.

3. Follow the on-screen instruction to complete the installation. 

https://www.microsoft.com/en-us/download/details.aspx?id=48145
http://www.aten.com/global/en/support-and-downloads/downloads/
http://www.aten.com/global/en/support-and-downloads/downloads/
https://www.aten.com/global/en/supportcenter/downloads/
https://www.aten.com/global/en/supportcenter/downloads/
https://www.aten.com/global/en/products/professional-audiovideo/control-system/controlassist/
https://www.aten.com/global/en/products/professional-audiovideo/control-system/controlassist/
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4. When the installation is complete, ControlAssist  runs in the system 
tray.

Note: Keep the ControlAssist program enabled in the system tray to allow 
the controller to establish connection with the computer.

5. To configure ControlAssist, right-click  in the system tray and select 
Settings. This window appears.

Click the Basic Settings, Certification & Private Key, or About ATEN 
ControlAssist to access the following settings/information.

Control Default Description

Basic Settings
The settings with which an ATEN controller needs to establish connection with the 
computer and to gain control right.

Username admin The credentials required for an ATEN 
controller to establish connection with the 
computer. 
Note: To change the username and 
password, make sure to log in the computer 
using an Administrator account.

Password password

Port 6277 The port through which ATEN Configurator 
establishes connection with the 
ControlAssist-installed computer.
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Note: If the text in the ControlAssist window appears oversized, change 
the desktop font size to its default, and then log in the computer 
again to resolve the issue.

Session timeout 3600 The maximal time allowed for the controller to 
establish connection with ControlAssist.

Root Folder N/A This field specifies the computer path under 
which files are display in the PowerPoint 
Control and Media templates’ file list. To 
display files at the computer’s partition level, 
type %MY_COMPUTER% in this field.

Upload SSL Certificate and Private Key
Upload an SSL certificate and its private key to secure sessions between the 
computer and the connected controller.

Certificate Default 
certificate

Click Choose a file from... to browse for an 
SSL certificate.

Private key Default 
private key

Click Choose a file from... to browse for a 
private key SSL certificate.

About ATEN ControlAssist

Version N/A Indicates the release version. 

Visit Official Website N/A Click to open the official website for more 
information.

Control Default Description
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Adding Target Computers to the Control System
After you have installed ControlAssist on the computers you wish to control, 
follow the steps below to establish connection between the controller and the 
target computers.

1. From ATEN Configurator, locate and open your project file.

2. Click the Device tab, and from the Ethernet device type category, click on 
a blank device or click Add More Devices to add one.

3. Click Library. This window appears.
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4. Use the search box to search for “controlassist” to load the ControlAssist 
database. This screen appears.

5. Click Add to Project. This computer, identified as an Ethernet device 
installed with ControlAssist, appears in the Device Configuration List.

6. Select the newly added device and configure the Properties settings on the 
right of the interface.
Hint: If you have more than one computers installed with ControlAssist, 
change the device name to distinguish these PCs.

For details on Properties settings, see Ethernet Device Properties, page 96.
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Configuring a Control Interface
Example 1:

Follow the steps below to create a control interface that allows you to browse 
and play any file from the specified root folder (see page 207) in the target 
computer. You can follow the same logic for creating a media control page.

1. In the Design tab, make sure your home page contains a presentation 
button and the Viewer contains a PowerPoint page. 

2. Configure the button to have it link to the PowerPoint page if pressed in 
the Viewer.

a) Click the presentation button.

b) Select Link and then double-click the PowerPoint page.
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3. Configure the PowerPoint page if you did not use a built-in Viewer 
template. 

a) In the left sidebar, click PowerPoint.

b) In the PowerPoint page, right-click any blank spot and select 
PowerPoint Control Template. A pre-made screen is added.

c) In the Properties column, use the Select Device drop-down menu to 
select the PC that stores the PowerPoint files you want to play.
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Example 2: 

Follow the steps below to create a quick access button for opening and playing 
a specific PowerPoint file. You can follow the same logic to create a button for 
opening and playing a specific media file. 

1. Create an outlook for the interface.

a) In ATEN Configurator, click the Design tab.

b) Click Add Page and rename the page to “presentation”.

c) Customize the interface and add control buttons using the Properties 
settings in the right-hand column. For details, see Design, page 100.

2. Define the action of each button. For example, for the PowerPoint button to 
open and start a slide show when pressed, do the following:

a) In the preview pane, click the PowerPoint button.

b) Select ControlAssist (LAN).

c) Double-click [PowerPoint] Open file and then [PowerPoint] Start 
presentation.

d) Configure the commands and arrange them in the order of execution.
Tip: The asterisk (*) at the end of a Function indicates that it requires 
configuration in the Commands column.

For details on supported control actions, see Supported PC Control Actions, 
page 215.

3. From the Upload tab, deploy and back up the project to the controller. For 
details, see Upload, page 182.

2b

2a

2c 2d
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Supported PC Control Actions

Command Function

Note: Commands indicated with an asterisk require configuration after being added to 
the Commands column in the Configurator.

[Media Control] 
Note: The commands in this group apply to Windows Media Player only.

Close Closes the player.

Next Plays next in the playlist.

Open file* Opens and plays the specified file in Windows Media 
Player.

Open playlist* Opens and plays the specified playlist in Windows Media 
Player.

Pause Pauses the playback.

Play Plays the opened file in Windows Media Player.

Previous Plays previous in the playlist.

Set volume to* Sets the player to a specified volume.

Stop Stops the playback.

Switch to full screen mode* Enables or disables the player to full-screen display.

Switch to mute mode* Enables or disables mute mode.

Switch to repeat mode* Enables or disables repeated play.

Volume* Adjusts the player’s volume up or down.

[PowerPoint Control]

Open file* Opens the specified PowerPoint file.

Start presentation Starts the slide show of the specified PowerPoint file.

End presentation Ends the slide show of the specified PowerPoint file.

Close Closes the opened PowerPoint file.

Go to next slide* Goes to the next slide.

Go to previous slide Goes to the previous slide.

Go to slide Goes to a specified slide number.

[System Control]

Open file* Opens a specified file saved in the target computer.

Open URL* Opens a specified URL.

Run program* Runs an application.

Shut down PC Shuts down the computer.
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Note: Adhere to the following guidelines when specifying file paths:
Include the file name and file extension of the target file.
Use double backward slashes between folder levels.
If the file path contains space, put the file path in double quotations. 
The following are examples of valid file paths:
“C:\\ControlAssist\\Presentation.pptx”

“C:\\ControlAssist\\Presentation Demo.pptx”

Set volume* Adjusts the computer’s volume.

Execute Command 
Prompt*

Executes the specified command via Command Prompt.

Bring application to top* Keeps the window of the specified program on top of 
other windows that are open on the desktop.

[Hotkey Control]

Create action Executes the associated hotkey(s) on the program that 
opens topmost on the computer desktop. 

For example, if you have “Ctrl + f” defined as the hotkey for 
extending a program to full screen in the program itself, to 
remotely simulate this action, you should have one Create 
action command associated with two Select key 
commands, one defined as “Ctrl”, and the other as “f”:

Select key* Use this command to specify the hotkey as defined in the 
target program. If the hotkey involves pressing two or 
more keys at the same time, you will have two or more 
Select key commands associated to one Create action 
command. See the example in the Create action 
command above.

Command Function

Note: Commands indicated with an asterisk require configuration after being added to 
the Commands column in the Configurator.
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Chapter 7
ATEN Control System App

Overview

The ATEN Control System App is a free app that allows you to download 
Viewers to be used on mobile devices. These Viewers provide the interface for 
remote control of hardware devices.

Requirements

Make sure your mobile device uses a supported version of the mobile operating 
system listed below before installing the app.

Installing the App

To install the ATEN Control System App on a mobile device, do the following:

1. From the mobile device, tap the App Store  or Google Play  

icon.

2. In the search box, type “aten control”.

3. Tap ATEN Control System, and then download and install the app. 

4. The ATEN Control System icon appears on the mobile device.

5. Tap the icon to open the app. 

Button Sounds
After you install the app, go to the mobile device Settings and find the ATEN 
Control so that you can enable/disable the Button Sound setting. 

Mobile Operating System Supported Version

iOS 10.0 or later

Android 8.0 or later

Windows 7 or later
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The ATEN Control System App

When you open the ATEN Control System app for the first time, the default 
Welcome screen appears:

Tap Demo to try the ATEN Control System app. Tap Start to find a controller 
and download Viewers (see Welcome, page 222). 

Note: The default Welcome screen appears until a Viewer is downloaded to the 
mobile device. After a Viewer is downloaded, the default Welcome screen will 
reappear only if the app is reinstalled, which will also delete all Viewers.
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Demo

The Demo page provides a preview of the ATEN Control System app with two 
sample rooms. Tap either room to view the controls of different hardware 
devices. Tap Quit Demo at the top right corner to exit.

Select a Viewer or press any of the buttons on the Welcome page to demo the 
app. The first Viewer’s name will depend on the OS of the device. 

WinViewer1 / iPad / Android1

This demo shows a Conference call interface with controls for a Projector, 
Screen and Lighting. Tap any of the device icons to open the control page. 
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Control Pages

The images above show the Main page and pages for the Projector, Screen 
and Lights. 

Demo

This demo shows different buttons that can be pressed to control the Projector, 
Lights, Video Wall and Camera. Tap the icons to view control pages for each 
device. Tap the Quit Demo icon to return to the previous page, or press on the 
background until the logout dialog appears.
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Control Pages

The images above show control pages for the Projector, Lights, Video Wall 
and Camera in Demo. Tap the Home icon in the lower left corner to return to 
the previous page, or press on the background until the logout dialog appears.
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Welcome

The Welcome screen is the home screen of the ATEN Control System app. It 
lists the Viewers and provides administrative options. Tap a Viewer to open the 
controls for a room (see Design, page 100), or use the administrative options 
listed below.

Icon Description

Manage Viewer – This page provides options to add, update and 
remove downloaded Viewers. See page 223 for details.

Manage IP – This page provides options to configure network 
settings for controllers and LAN devices. See page 224 for details.

Set Password – This page provides options to set a password for 
access to the Welcome page when a Viewer is in use. See 
page 227 for details.

Log Report – This page provides an error log to troubleshoot 
connectivity issues. See page 228 for details.

Information – This page provides information about the ATEN 
Control System’s software version. See page 230 for details.
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Manage Viewer
The Manage Viewer page allows you to add, update, and remove 
downloaded Viewers. To download Viewers, tap Add Viewer (see Set 
Password, page 227). 

Icon Description

Add Viewer Tap Add Viewer to download Viewers. See page 231 for details.

Tap the Information icon to view the MAC Address, IP Address 
and Controller ID of the controller associated with the Viewer.

Update Tap Update to connect to the controller and download an updated 
version of the Viewer. After the update, the “Downloaded 
Successfully” prompt will appear

Remove Tap Remove to delete the Viewer. A dialog box will appear to 
confirm deletion of the Viewer. 

Tap Delete to remove the Viewer, or Cancel to cancel the deletion.

Note: Viewers are only deleted on the mobile device, and will still 
be available on the controller. 

Done Tap Done to return to the Welcome page. 

Add Viewer Tap Add Viewer to download Viewers. See page 231 for details. 
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Manage LAN Device
The Manage LAN Device page allows you to edit network settings for 
the controllers and LAN devices added in the Configurator software 

(see Device Library, page 99). 

 Tap to expand controllers to view connected LAN devices.

 Tap to open the web GUI (see Browser Operation, page 55).
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Depending on the LAN device you select, different options are available.Tap 
on a device to open the settings page. Use Edit to change settings, Apply to 
save or OK to exit.

Controller

PJLink Projector 

Telnet 
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ONVIF 

TCP 

UDP
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Set Password
The Set Password page sets a password to access the Welcome page 
from a Viewer. This prevents unauthorized users from changing the 

app settings. Users will be prompted for a password before they exit Viewers 
to access the Welcome page. 

Slide the Enable Password Protect button, enter a password in the box and 
tap Set. The Show Password option appears after you check enable Password 
Protect, allowing you to display the characters typed in for the password. Enter 
a number in Seconds to press before exit dialog appears to set the amount of 
time to pass when pressing on a viewer page before a window appears asking 
if you want to exit. Tap Back to exit. 



ATEN Control System User Manual

228

Log Report
The Log Report page lists information and errors which can be used 
to troubleshoot issues. Tap and drag the list to scroll through the 
logs.  Tap Back to exit. 

 Tap Save to save the log file.

 Tap Report History to view saved logs (see page 229).

 Tap Delete to delete the log information.

 Tap Back to exit.
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Report History
When you tap Report History, you can view and export logs. Saved 
log files are listed by date in the left column. Tap a log file to view it 
in the window to the right. Tap and drag the list to scroll through the 
logs. Tap Back to exit.

 Tap Export to send the log as an e-mail attachment.
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Information
The Information page displays the ATEN Control System’s version.
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Download Viewer

The Download Viewer page allows you to search for controllers and 
download Viewers. This page is accessed from Welcome → Manage 
Viewer → Add Viewer.

Search by IP 
Address

Tap to enter a controller’s IP address, then tap the Search icon to 
find it. When controllers are found on the network, they are listed in 
the Add Viewer box.
A Search History drop-down menu will appear for previously 
searched IP addresses. 

Auto Search Auto Search allows you to search for controllers without specifying 
an IP address. The controller must be powered on and connected 
to the same local network. 

Add Viewer This panel lists the controllers that have been found on the network. 
Each controller lists Viewers that can be downloaded to the mobile 
device. To upload Viewers to a controller, see Upload, page 182.

Back Icon Back returns you to the Welcome page.
Download After you select the Viewers you want to download, click Download 

to start the process.
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Downloading Viewers
When controllers are found, they appear in the Add Viewer 
panel. Check the boxes of the Viewers you would like to 

download, then tap Download. 

Add Viewer The main window lists the controllers that have been found on the 
network. Under each controller is a list of Viewers with a check box. 
Use the check boxes to select the Viewers you want to download, 
then click Download. If the Lock icon appears, you will be 
prompted to enter the access key. 
After Viewers download, the “Downloaded Successfully” prompt 
appears. Tap Done to return to the Welcome page where the 
Viewers will be listed. 
Note: After you download a Viewers to the mobile device, the 
default Welcome screen no longer appears. 

Access Key When the a Viewers requires an access key a window appears 
prompting you to enter the key. Enter the correct access key and 
then click OK to download the Viewers from the controller. To set 
the access key, see Upload, page 182. 
Tap the Information icon to view the IP Address, MAC Address 
and License information of the controller. The license information 
provides the total number of licenses available and the number in 
use. 
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Appendix

Safety Instructions

General
Read all of these instructions. Save them for future reference.
Follow all warnings and instructions marked on the device.
This product is for indoor use only.
Do not place the device on any unstable surface (cart, stand, table, etc.). If 
the device falls, serious damage will result.
Caution: Risk of explosion if the battery is replaced by an incorrect type. 
Always dispose of used batteries according to the proper instructions.
Do not use the device near water.
Do not place the device near, or over, radiators or heat registers.
The device cabinet is provided with slots and openings to allow for 
adequate ventilation. To ensure reliable operation, and to protect against 
overheating, these openings must never be blocked or covered.
The device should never be placed on a soft surface (bed, sofa, rug, etc.) as 
this will block its ventilation openings. Likewise, the device should not be 
placed in a built in enclosure unless adequate ventilation has been provided.
Never spill liquid of any kind on the device.
Unplug the device from the wall outlet before cleaning. Do not use liquid 
or aerosol cleaners. Use a damp cloth for cleaning.
The device should be operated from the type of power source indicated on 
the marking label. If you are not sure of the type of power available, 
consult your dealer or local power company.
The device is designed for IT power distribution systems with 230V 
phase-to-phase voltage.
To prevent damage to your installation it is important that all devices are 
properly grounded.
The device is equipped with a 3-wire grounding type plug. This is a safety 
feature. If you are unable to insert the plug into the outlet, contact your 
electrician to replace your obsolete outlet. Do not attempt to defeat the 
purpose of the grounding-type plug. Always follow your local/national 
wiring codes.
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Do not allow anything to rest on the power cord or cables. Route the 
power cord and cables so that they cannot be stepped on or tripped over.
If an extension cord is used with this device make sure that the total of the 
ampere ratings of all products used on this cord does not exceed the 
extension cord ampere rating. Make sure that the total of all products 
plugged into the wall outlet does not exceed 15 amperes.
To help protect your system from sudden, transient increases and 
decreases in electrical power, use a surge suppressor, line conditioner, or 
un-interruptible power supply (UPS).
Position system cables and power cables carefully; Be sure that nothing 
rests on any cables.
Never push objects of any kind into or through cabinet slots. They may 
touch dangerous voltage points or short out parts resulting in a risk of fire 
or electrical shock.
Do not attempt to service the device yourself. Refer all servicing to 
qualified service personnel.
If the following conditions occur, unplug the device from the wall outlet 
and bring it to qualified service personnel for repair.

The power cord or plug has become damaged or frayed.
Liquid has been spilled into the device.
The device has been exposed to rain or water.
The device has been dropped, or the cabinet has been damaged.
The device exhibits a distinct change in performance, indicating a need 
for service.
The device does not operate normally when the operating instructions 
are followed.

Only adjust those controls that are covered in the operating instructions. 
Improper adjustment of other controls may result in damage that will 
require extensive work by a qualified technician to repair.
Avoid circuit overloads. Before connecting equipment to a circuit, know 
the power supply’s limit and never exceed it. Always review the electrical 
specifications of a circuit to ensure that you are not creating a dangerous 
condition or that one doesn’t already exist. Circuit overloads can cause a 
fire and destroy equipment.
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Rack Mounting
Before working on the rack, make sure that the stabilizers are secured to 
the rack, extended to the floor, and that the full weight of the rack rests on 
the floor. Install front and side stabilizers on a single rack or front 
stabilizers for joined multiple racks before working on the rack.
Always load the rack from the bottom up, and load the heaviest item in the 
rack first.
Make sure that the rack is level and stable before extending a device from 
the rack.
Use caution when pressing the device rail release latches and sliding a 
device into or out of a rack; the slide rails can pinch your fingers.
After a device is inserted into the rack, carefully extend the rail into a 
locking position, and then slide the device into the rack.
Do not overload the AC supply branch circuit that provides power to the 
rack. The total rack load should not exceed 80 percent of the branch circuit 
rating.
Make sure that all equipment used on the rack – including power strips and 
other electrical connectors – is properly grounded.
Ensure that proper airflow is provided to devices in the rack.
Ensure that the operating ambient temperature of the rack environment 
does not exceed the maximum ambient temperature specified for the 
equipment by the manufacturer.
Do not step on or stand on any device when servicing other devices in a 
rack.
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Technical Support
International

For online technical support – including troubleshooting, documentation, 
and software updates: http://eservice.aten.com
For telephone support, see Telephone Support, page iii:

North America

When you contact us, please have the following information ready beforehand:
Product model number, serial number, and date of purchase.
Your computer configuration, including operating system, revision level, 
expansion cards, and software.
Any error messages displayed at the time the error occurred.
The sequence of operations that led up to the error.
Any other information you feel may be of help.

Email Support support@aten-usa.com

Online 
Technical 
Support

Troubleshooting
Documentation
Software Updates

https://eservice.aten.com

Telephone Support 1-888-999-ATEN ext 4988
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Datapoint Types

ATEN Control System supports the following KNX Datapoint Types (DPT): 

DPT ID DPT Format DPT Name

1.001 B1 DPT_Switch

1.002 B1 DPT_Bool

1.003 B1 DPT_Enable

1.004 B1 DPT_Ramp

1.005 B1 DPT_Alarm

1.006 B1 DPT_BinaryValue

1.007 B1 DPT_Step

1.008 B1 DPT_UpDown

1.009 B1 DPT_OpenClose

1.010 B1 DPT_Start

1.011 B1 DPT_State

1.012 B1 DPT_Invert

1.013 B1 DPT_DimSendStyle

1.014 B1 DPT_InputSource

1.015 B1 DPT_Reset

1.016 B1 DPT_Ack

1.017 B1 DPT_Trigger

1.018 B1 DPT_Occupancy

1.019 B1 DPT_Window_Door

1.021 B1 DPT_LogicalFunction

1.022 B1 DPT_Scene_AB

1.023 B1 DPT_ShutterBlinds_Mode

1.100 B1 DPT_Heat/Cool

2.001 B2 DPT_Switch_Control

2.002 B2 DPT_Bool_Control

2.003 B2 DPT_Enable_Control

2.004 B2 DPT_Ramp_Control
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2.005 B2 DPT_Alarm_Control

2.006 B2 DPT_BinaryValue_Control

2.007 B2 DPT_Step_Control

2.008 B2 DPT_Direction1_Control

2.009 B2 DPT_Direction2_Control

2.010 B2 DPT_Start_Control

2.011 B2 DPT_State_Control

2.012 B2 DPT_Invert_Control

3.007 B1U3 DPT_Control_Dimming

3.008 B1U3 DPT_Control_Blinds

4.001 A8 DPT_ASCII

4.002 A8 DPT_Char_8859_1

5.001 U8 DPT_Scaling

5.003 U8 DPT_Angle

5.004 U8 DPT_Percent_U8

5.005 U8 DPT_DecimalFactor

5.006 U8 DPT_Tariff

5.010 U8 DPT_Value_1_Ucount

6.001 V8 DPT_Percent_V8

6.010 V8 DPT_Value_1_Count

6.020 B5N3 DPT_Status_Mode3

7.013 U16 DPT_Brightness

8.011 V16 DPT_Rotation_Angle

9.001 F16 DPT_Value_Temp

18.001 B1R1U6 DPT_SceneControl

20.100 N8 DPT_FuelType

20.101 N8 DPT_BurnerType

20.102 N8 DPT_HVACMode

20.103 N8 DPT_DHWMode

20.104 N8 DPT_LoadPriority

DPT ID DPT Format DPT Name
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20.105 N8 DPT_HVACContrMode

20.106 N8 DPT_HVACEmergMode

20.107 N8 DPT_ChangeoverMode

20.108 N8 DPT_ValveMode

20.109 N8 DPT_DamperMode

20.110 N8 DPT_HeaterMode

20.111 N8 DPT_FanMode

20.112 N8 DPT_MasterSlaveMode

20.113 N8 DPT_StatusRoomSetp

23.001 N2 DPT_OnOff_Action

23.002 N2 DPT_Alarm_Reaction

23.003 N2 DPT_UpDown_Action

23.102 N2 DPT_HVAC_PB_Action

DPT ID DPT Format DPT Name
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Specifications

VK2100

Function VK2100

Interface Serial 4 x Programmable Bi-directional RS-232/422/
485 Ports (4 x DB9 Male Connectors, 

Configurable via Pin Assignments)

Baud Rate: 300 to 115200 (default: 9600)
Data Bit: 8 (default) or 7
Stop Bit: 1 (default) or 2

Parity: None (default), Even or Odd
Flow Control: None (default) RTS/CTS

2 x Bi-directional RS-232 Ports (2 x 3-Pole 
Terminal Block Connectors)

Baud Rate: 300 to 115200 (default: 9600)
Data Bit: 8 (default) or 7
Stop Bit: 1 (default) or 2

Parity: None (default), Even or Odd

IR/Serial 4 x Programmable IR / Uni-directional RS-232 
Ports (2 x 4-Pole Terminal Block Connectors)

IR: TTL level (0 to 5 V)
Carrier Frequency: 10KHz~455KHz

Serial: Uni-directional RS-232 ( + - 5 V)
Baud Rate: 300 to 115200 (default: 9600)

Data Bit: 8 (default) or 7
Stop Bit: 1 (default) or 2

Parity: None (default), Even or Odd

I/O 4 x Programmable Digital Input / Output 
Channels (1 x 5-Pole Terminal Block Connector)

Digital Output: 250 mA sink from 12 VDC

Digital Input:
VDC Mode 

Input Voltage Range: 0 to 24 VDC
Programmable Range: 1 to 24 VDC

Dry Contact Mode:
Pull-up 2k ohms to + 12 VDC

Relay 4 x Relay Channels (2 x 4-Pole Terminal Block 
Connector)

Normally Open, Isolated Relays
Contact Rating: Max 24 VDC, 2A

VDC 4 x 12 VDC Output Ports (2 x 4-Pole Terminal 
Block Connectors)

Power Supply: 12 VDC, 2A Max (Shared By 4 
Ports)

Connectors Ethernet 1 x RJ-45 Female, 10/100Base-T

USB 1 x USB Type A Female (White)

Power 1 x 3-prong AC power socket
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Switches Controller ID 1 x 16-Segment Switch

Power 1 x Rocker Switch

Reset 1 x Semi-recessed pushbutton

LEDs Relay 4 (Green)

IR / Serial 4 (Green)

I/O 4 (Green)

Serial RX 6 (Green)

TX 6 (Green)

Ethernet Link 1 (Green)

Act 1 (Green)

DC Output Overload 1 (Orange)

IR Learn 1 (Green)

USB 1 (Green / Orange)

Power 1 (Green)

IR Receiver 1 x IR Receiver Port

I/P Rating 100-240 VAC, 50-60 Hz, 1A

Power Consumption 40 Watt

Environment Operating Temp. 0–50ºC

Storage Temp. -20–60ºC

Humidity 0–80% RH, Non-condensing

Physical 
Properties

Housing Metal

Weight 2.64 kg

Dimensions (L x W x H) 43.72 x 16.32 x 4.40 cm

Licenses for 
mobile control

No. of Free Licenses 2

Max. No. of Allowed Licenses 10

Function VK2100
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VK1100
Function VK1100

Interface Serial 2 x Programmable Bi-directional RS-232/422/
485 Ports (2 x DB9 Male Connectors, 

Configurable via Pin Assignments)

Baud Rate: 300 to 115200 (default: 9600)
Data Bit: 8 (default) or 7
Stop Bit: 1 (default) or 2

Parity: None (default), Even or Odd
Flow Control: None (default) RTS/CTS

IR/Serial 2 x Programmable IR / Uni-directional RS-232 
Ports (1 x 3-Pole Terminal Block Connectors)

IR: TTL level (0 to 5 V)
Carrier Frequency: 10KHz~455KHz

Serial: Uni-directional RS-232 (0-5 V)
Baud Rate: 300 to 115200 (default: 9600)

Data Bit: 8 (default) or 7
Stop Bit: 1 (default) or 2

Parity: None (default), Even or Odd

Relay 4 x Relay Channels (2 x 4-Pole Terminal Block 
Connector)

Normally Open, Isolated Relays
Contact Rating: Max 24 VDC, 2A

VDC 1 x 12 VDC Output Ports (1 x 2-Pole Terminal 
Block Connectors)

Power Supply: 12 VDC, 1A Max

Connectors Ethernet 1 x RJ-45 Female, 10/100Base-T

USB 1 x USB Type A Female (White)

Power 1 x 3-prong AC power socket

Switches Controller ID 1 x 16-Segment Switch

Power 1 x Rocker Switch

Reset 1 x Semi-recessed pushbutton

LEDs Relay 4 (Green)

IR / Serial 2 (Green)

Serial RX 2 (Green)

TX 2 (Green)

Ethernet Link 1 (Green)

Act 1 (Green)

DC Output Overload 1 (Orange)

IR Learn 1 (Green)

USB 1 (Green / Orange)

Power 1 (Green)

IR Receiver 1 x IR Receiver Port

I/P Rating 100-240 VAC, 50-60 Hz, 1A
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Power Consumption 20 Watts

Environment Operating Temp. 0–50ºC

Storage Temp. -20–60ºC

Humidity 0–80% RH, Non-condensing

Physical 
Properties

Housing Metal

Weight 1.19 kg

Dimensions (L x W x H) 21.50 x 16.23 x 4.18 cm

Licenses for 
mobile control

No. of Free Licenses 2

Max. No. of Allowed Licenses 10

Function VK1100
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VK0100/VK0200
Function VK0100 VK0200

Interface Keypad Layout Up to 14 layout variations using 
4 ~ 8 buttons 

Up to 125 layout variations 
using 6 ~ 12 buttons

Serial • 2 x Bi-directional RS-232 Port (2 x 3-Pole Terminal Block 
Connector)

• Baud Rate: 300 to 115200 (default: 9600)

• Data Bit: 8 (default) or 7

• Stop Bit: 1 (default) or 2

• Parity: None (default), even or odd

Relay • 2 x Relay Channel (2 x 2-Pole Terminal Block Connector)

• Normally open, isolated Relays

• Contact Rating: Max 24 VDC, 1A

Digital Input • 1 x Digital Input Channel (1 x 2-Pole Terminal Block 
Connector); 

• VDC Mode 

 - Input Voltage Range: 0 to 5 VDC

 - Programmable Range: 1 to 5 VDC

• Dry Contact Mode 

 - Pull-up 2k ohms to + 5 VDC

Ethernet • 1 x RJ-45 Female, 10/100Base-T 

• Supported Protocol: ARP, ICMP, TCP/IP, DHCP, HTTPS, SSH 

• DHCP-enabled. The following default IP settings will be used 
if no IP is assigned within 30 seconds: 

IP: 192.168.0.60 

Subnet Mask: 255.255.255.0

Switches Controller ID 1 x 16-segment Switch

Reset Button 1 x Semi-recessed Pushbutton

Power Consumption DC5V: 1.16W; DC48V: 1.375W DC5V: 1.15W; DC48V: 
1.44W

Environmental Operating 
Temperature

0 – 50°C

Storage 
Temperature

–20 – 60°C

Humidity 0 - 80% RH, Non-Condensing

Physical 
Properties

Housing Plastic

Weight 0.35 kg (0.77 lb) 0.38 kg (0.84 lb)

Dimension 11.63 x 7.06 x 4.84 cm

(4.58 x 2.78 x 1.91 in)

8.32 x 14.76 x 4.84 cm

(3.28 x 5.81 x 1.91 in)
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Licenses for 
mobile control

No. of Free 
Licenses

0

Max. No. of 
Allowed 
Licenses

10

Function VK0100 VK0200
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Windows OS Button Limitation

When adding buttons to a Viewer page for use on a Windows mobile device 
there is a Windows OS limitation for overlapping buttons. When two buttons 
are layered (A) on top of (B), the top most button (A) can not be pressed – 
instead (B) is activated each time. To resolve this issue, duplicate the top most 
button (A) and add it (C) directly under (A) and below (B) on the Viewer page. 

When the top button (A) is pressed, the lowest button (C) will execute the 
action. 
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Limited Warranty

ATEN warrants its hardware in the country of purchase against flaws in 
materials and workmanship for a Warranty Period of two [2] years (warranty 
period may vary in certain regions/countries) commencing on the date of 
original purchase. This warranty period includes the LCD panel of ATEN LCD 
KVM switches. Select products are warranted for an additional year (see A+ 
Warranty for further details). Cables and accessories are not covered by the 
Standard Warranty.

What is covered by the Limited Hardware Warranty
ATEN will provide a repair service, without charge, during the Warranty 
Period. If a product is detective, ATEN will, at its discretion, have the option 
to (1) repair said product with new or repaired components, or (2) replace the 
entire product with an identical product or with a similar product which fulfills 
the same function as the defective product. Replaced products assume the 
warranty of the original product for the remaining period or a period of 90 days, 
whichever is longer. When the products or components are replaced, the 
replacing articles shall become customer property and the replaced articles 
shall become the property of ATEN.

To learn more about our warranty policies, please visit our website:
http://www.aten.com/global/en/legal/policies/warranty-policy/


	EMC Information
	Safety
	User Information
	Online Registration
	Telephone Support
	User Notice

	Package Contents
	VK0100
	VK0200
	VK1100
	VK2100

	Contents
	About this Manual
	Conventions
	Terminology
	Product Information
	Chapter 1 Introduction
	Overview
	Benefits
	Intelligent Control
	Optimized Performance
	Simplified Setup
	Effortless Expandability
	User Centered Convenience
	On-the-Go Control

	Features
	ATEN Control Box
	ATEN Control Pad
	ATEN Configurator
	ATEN Control System App
	ATEN Keypads

	Requirements
	Accessories

	Chapter 2 Hardware Setup
	ATEN Control Box
	Panel Components
	VK2100 Front View
	VK2100 Rear View
	VK1100 Front View

	Rack Mounting the ATEN Control Box
	VK2100
	VK1100

	Control Box Connections
	12VDC Power Output
	Relay
	IR / Serial
	One IR Transmitter
	Two IR Transmitters

	Digital I/O
	RS-232
	RS-232 / 422 / 485
	Ethernet

	ATEN Control Pad
	Panel Components
	Installing the Control Pads
	Installation Steps


	Accessories
	ATEN Expansion Box
	ATEN Keypad
	Installation
	Component
	Layout Examples



	Chapter 3 Browser Operation
	Overview
	Logging In
	Dashboard
	Settings
	Licenses for Mobile Control
	Storage
	Access
	Monitor
	Network
	Connections
	Schedule
	Security


	Chapter 4 ATEN Configurator (VK6000)
	Overview
	Installation
	Getting Started Tasks
	Main Page
	Menu Bar
	Project
	Device
	Device Configuration List
	Adding Devices to ATEN Configurator

	Left Sidebar
	Properties
	Controller Properties

	Library
	Device Library

	Design
	Overview
	Left Sidebar
	Viewer
	Pages

	Adding a Viewer
	Configuring the Viewer

	Object Properties
	Page Objects
	Object Properties for Mobile Devices
	Buttons
	Groups
	Labels
	Slider Bars
	PowerPoint Control and Media Control Templates
	Image
	Layering Images
	Dial Kit
	Frame & Line

	Object Properties for ATEN Keypad / Control Pad

	Button / Slider Bar / Dial Kit Actions
	Understanding Button/Slider Bar/Dial Kit Actions
	Configuring Button/Slider Bar Actions
	Functions
	Device Functions
	Applications of Device Functions
	Example 1: Configuring actions of dial keys.

	Advanced Functions
	Applications of Advanced Functions
	Set Flag

	Graphic Library
	Background Color
	Button
	Icon
	Device Interface


	Library
	Flag
	Monitor
	Understanding Monitor
	Monitor Page Options

	Macro
	Scheduled Events
	Variables
	Understanding Variables


	Upload
	Viewing Controller Information


	Chapter 5 ATEN Database Generator
	Overview
	My Library
	Managing My Library
	Overview
	Edit / Add New Device

	ATEN Library


	Chapter 6 Remote PC Control
	Overview
	Specifications
	Setting Up Remote PC Control
	Installing ControlAssist on Target Computers
	Adding Target Computers to the Control System
	Configuring a Control Interface
	Supported PC Control Actions



	Chapter 7 ATEN Control System App
	Overview
	Requirements
	Installing the App
	Button Sounds

	The ATEN Control System App
	Demo
	WinViewer1 / iPad / Android1
	Demo

	Welcome
	Manage Viewer
	Manage LAN Device
	Controller

	Set Password
	Log Report
	Report History
	Information

	Download Viewer
	Downloading Viewers


	Appendix
	Safety Instructions
	General
	Rack Mounting

	Technical Support
	International
	North America

	Datapoint Types
	Specifications
	VK2100
	VK1100
	VK0100/VK0200

	Windows OS Button Limitation
	Limited Warranty


